3. **Viewing Pages in Document Composer** ......................................................... 37
   - On Demand Viewing in Document Composer ............................................. 37
   - Viewing Simulated or Live Data in Document Composer ................................. 38
     - Procedure: How to Preview Reports and Graphs Using Simulated Data. .......... 38
     - Procedure: How to Preview Reports and Graphs Using Live Data. .............. 39
   - Reference: Developer Studio Options Document Tab ...................................... 40
   - Moving Pages With the Thumbnails Tab ..................................................... 42
     - Procedure: How to Move Pages With the Thumbnails Tab. ......................... 42
   - Positioning Objects and Keyboard Shortcuts .............................................. 45

4. **Using Page Masters in Document Composer** .............................................. 47
   - Creating, Saving, and Editing Page Masters in Document Composer .................. 47
     - Procedure: How to Create a Page Master in Document Composer .................... 48
     - Procedure: How to Save a Page Master in Document Composer ...................... 48
     - Reference: Saving Page Masters ........................................................... 49
     - Reference: Editing Objects in the Page Master .......................................... 49
   - Using an Existing Page Master in Another Document .................................... 49
     - Procedure: How to Use an Existing Page Master in Another Document .......... 49

5. **Controlling the Overflow and Relative Positioning of Objects** ...................... 51
   - Setting Overflow Options in Document Composer ......................................... 52
   - Using Fixed Overflow in Document Composer .............................................. 56
     - Procedure: How to Customize the Overflow for a Fixed Report ..................... 56
   - Using Flowing Overflow in Document Composer .......................................... 57
     - Procedure: How to Set the Flowing Report Property. .................................. 58
     - Procedure: How to Set Flow Margins for the Page Layout. .......................... 60
   - Setting a Relative Position Between Objects in Document Composer ................ 62
     - Procedure: How to Relate Surrounding Objects to a Report ......................... 63
     - Reference: Rules for Setting Relationships Between Objects ...................... 66
   - Adding Different Headers and Footers on an Overflow Page .......................... 67
     - Procedure: How to Add a New Overflow Page to a Page Layout .................... 68
     - Procedure: How to Add Header and Footer Information to the Overflow Page .... 71
     - Reference: Usage Notes for Adding Components to an Overflow Page ............ 73
# 6. Applying a Table of Contents and Bookmarks

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a Table of Contents Page</td>
<td>75</td>
</tr>
<tr>
<td>Procedure: How to Create a Table of Contents Page in Document Composer</td>
<td>75</td>
</tr>
<tr>
<td>Procedure: How to Control Which Objects Appear in the Table of Contents</td>
<td>76</td>
</tr>
<tr>
<td>Reference: Controlling Which Objects Appear in the Table of Contents</td>
<td>80</td>
</tr>
<tr>
<td>Reference: Properties for the Table of Contents Text Element</td>
<td>81</td>
</tr>
<tr>
<td>Using Bookmarks in Document Composer</td>
<td>83</td>
</tr>
<tr>
<td>Procedure: How to Use Bookmarks in Document Composer</td>
<td>83</td>
</tr>
</tbody>
</table>

# 7. Using Drill Through in Document Composer

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Drill Through</td>
<td>85</td>
</tr>
<tr>
<td>Procedure: How to Set the Drill Through Destination</td>
<td>85</td>
</tr>
<tr>
<td>Reference: Usage Notes for Drill Through</td>
<td>86</td>
</tr>
</tbody>
</table>

# 8. Using Page Layouts in Document Composer

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Page Layouts</td>
<td>87</td>
</tr>
<tr>
<td>Procedure: How to Save an Individual Page Layout in Document Composer</td>
<td>87</td>
</tr>
<tr>
<td>Procedure: How to Add an Existing Page Layout in Document Composer</td>
<td>88</td>
</tr>
<tr>
<td>Procedure: How to Insert an Existing Page Layout Before or After the Current Page Layout</td>
<td>88</td>
</tr>
<tr>
<td>Procedure: How to Insert a New Page Layout Before or After the Current Page Layout</td>
<td>89</td>
</tr>
<tr>
<td>Procedure: How to Set Different Page Orientations for Individual Page Layouts</td>
<td>90</td>
</tr>
</tbody>
</table>

# 9. Formatting Text in Document Composer

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Formatting Text Elements</td>
<td>93</td>
</tr>
<tr>
<td>Procedure: How to Apply Various Formatting in a Text Element</td>
<td>93</td>
</tr>
<tr>
<td>Procedure: How to Insert a Bulleted List or Numbered List Into a Text Element</td>
<td>95</td>
</tr>
<tr>
<td>Procedure: How to Insert Nested Lists Into a Text Element</td>
<td>96</td>
</tr>
<tr>
<td>Procedure: How to Apply Formatting to an Entire Text Element</td>
<td>97</td>
</tr>
<tr>
<td>Procedure: How to Align Text Within the Text Element</td>
<td>98</td>
</tr>
</tbody>
</table>

# 10. Adding Page Numbers to Your Document

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding Page Numbers to Your Document</td>
<td>101</td>
</tr>
<tr>
<td>Procedure: How to Add Page Numbering Objects in Document Composer</td>
<td>101</td>
</tr>
<tr>
<td>Reference: Page Numbering Options</td>
<td>102</td>
</tr>
<tr>
<td>Procedure: How to Reset Page Numbers in a Coordinated Compound Report</td>
<td>103</td>
</tr>
<tr>
<td>Reference: Restrictions for Importing Images in Document Composer</td>
<td>107</td>
</tr>
</tbody>
</table>
11. Creating Active Technologies Dashboards in Document Composer ........... 109
   Using Active Technologies Reports to Create Active Dashboards .................. 109
   Positioning Report Objects in the Active Technologies Dashboard .................. 112
     Procedure: How to Position Report Objects in the Active Technologies Dashboard. 112
   Working With Active Technologies Form Controls ........................................ 115
     Procedure: How to Create an Active Technologies Report With Active Technologies
               Dashboard Characteristics ......................................................... 116
   Procedure: How to Create an Active Technologies Dashboard in Document Composer. 117
   Binding Objects to an Active Technologies Report ........................................ 119
     Procedure: How to Synchronize Active Technologies Report Objects to Active
               Technologies Reports ............................................................... 119
     Procedure: How to Show Active Technologies Report Relationships ............... 120
   Configuring Active Technologies Form Controls in Document Composer ............ 120
     Procedure: How to Add an Active Technologies Form Control to the Layout ....... 121
     Procedure: How to Insert a Dashboard Bar Into the Layout ........................ 121
     Reference: Properties and Settings Dialog Box (Active Technologies Reports). .... 122
     Procedure: How to Chain Active Technologies Form Controls ..................... 123
     Procedure: How to Remove Active Technologies Form Controls From a Chain .... 124
   Switching the Chart Engine ........................................................................ 125
   Reference: Active Technologies Dashboard Mode ............................................ 126
A. Glossary ........................................................................................................... 127
Customer Connections ......................................................................................... 135
Preface

This manual describes how to create compound reports, and how to coordinate and distribute layouts in the local development environment using Document Composer. It is intended for developers.

**Note:** The WebFOCUS toolset generates the rich FOCUS fourth generation language. While this language is very extensive, the WebFOCUS toolset only supports a subset of the language and only specific syntax constructs. While the user can manually modify the content of these WebFOCUS procedures/files, there is no guarantee that the user will be able to open the modified procedure in the tool.

How This Manual Is Organized

This manual includes the following chapters:

<table>
<thead>
<tr>
<th>Chapter/Appendix</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Document Composer Overview</td>
<td>Describes uses for Document Composer and ways to access the tool and its features.</td>
</tr>
<tr>
<td>2 Creating Compound Reports</td>
<td>Describes how to create compound reports in Document Composer.</td>
</tr>
<tr>
<td>3 Viewing Pages in Document Composer</td>
<td>Describes the way pages are viewed and loaded in Document Composer.</td>
</tr>
<tr>
<td>4 Using Page Masters in Document Composer</td>
<td>Describes how to create, save, and use Page Masters in Document Composer.</td>
</tr>
<tr>
<td>5 Controlling the Overflow and Relative Positioning of Objects</td>
<td>Describes how to control the overflow and relative positioning of reports and graphs in Document Composer.</td>
</tr>
<tr>
<td>6 Applying a Table of Contents and Bookmarks</td>
<td>Describes how to create a Table of Contents page and how to use bookmarking to show specific reference points in your document.</td>
</tr>
<tr>
<td>7 Using Drill Through in Document Composer</td>
<td>Describes how to use Drill Throughs in Document Composer.</td>
</tr>
</tbody>
</table>
Documentation Conventions

The following table describes the documentation conventions that are used in this manual.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>THIS TYPEFACE</td>
<td>Denotes syntax that you must enter exactly as shown.</td>
</tr>
<tr>
<td>or</td>
<td></td>
</tr>
<tr>
<td>this typeface</td>
<td></td>
</tr>
<tr>
<td>this typeface</td>
<td>Represents a placeholder (or variable) in syntax for a value that you or the system must supply.</td>
</tr>
<tr>
<td>underscore</td>
<td>Indicates a default setting.</td>
</tr>
<tr>
<td>this typeface</td>
<td>Represents a placeholder (or variable), a cross-reference, or an important term. It may also indicate a button, menu item, or dialog box option that you can click or select.</td>
</tr>
<tr>
<td>Key + Key</td>
<td>Indicates keys that you must press simultaneously.</td>
</tr>
<tr>
<td>{ }</td>
<td>Indicates two or three choices. Type one of them, not the braces.</td>
</tr>
</tbody>
</table>
### Convention

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[ ] Indicates a group of optional parameters. None are required, but you may select one of them. Type only the parameter in the brackets, not the brackets.</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>... Indicates that you can enter a parameter multiple times. Type only the parameter, not the ellipsis (...).</td>
</tr>
<tr>
<td>. Indicates that there are (or could be) intervening or additional commands.</td>
</tr>
</tbody>
</table>

### Related Publications

Visit our Technical Content Library at [http://documentation.informationbuilders.com](http://documentation.informationbuilders.com). You can also contact the Publications Order Department at (800) 969-4636.

### Customer Support

Do you have questions about this product?

Join the Focal Point community. Focal Point is our online developer center and more than a message board. It is an interactive network of more than 3,000 developers from almost every profession and industry, collaborating on solutions and sharing tips and techniques. Access Focal Point at [http://forums.informationbuilders.com/eve/forums](http://forums.informationbuilders.com/eve/forums).

You can also access support services electronically, 24 hours a day, with InfoResponse Online. InfoResponse Online is accessible through our website, [http://www.informationbuilders.com](http://www.informationbuilders.com). It connects you to the tracking system and known-problem database at the Information Builders support center. Registered users can open, update, and view the status of cases in the tracking system and read descriptions of reported software issues. New users can register immediately for this service. The technical support section of [http://www.informationbuilders.com](http://www.informationbuilders.com) also provides usage techniques, diagnostic tips, and answers to frequently asked questions.
Information You Should Have

Call Information Builders Customer Support Services (CSS) at (800) 736-6130 or (212) 736-6130. Customer Support Consultants are available Monday through Friday between 8:00 a.m. and 8:00 p.m. EST to address all your questions. Information Builders consultants can also give you general guidance regarding product capabilities. Please be ready to provide your six-digit site code number (xxxx.xx) when you call.

To learn about the full range of available support services, ask your Information Builders representative about InfoResponse Online, or call (800) 969-INFO.

**Information You Should Have**

To help our consultants answer your questions effectively, be prepared to provide the following information when you call:

- Your six-digit site code (xxxx.xx).
- Your WebFOCUS configuration:
  - The front-end software you are using, including vendor and release.
  - The communications protocol (for example, TCP/IP or HLLAPI), including vendor and release.
  - The software release.
  - Your server version and release. You can find this information using the Version option in the Web Console.
- The stored procedure (preferably with line numbers) or SQL statements being used in server access.
- The Master File and Access File.
- The exact nature of the problem:
  - Are the results or the format incorrect? Are the text or calculations missing or misplaced?
  - Provide the error message and return code, if applicable.
  - Is this related to any other problem?
  - Has the procedure or query ever worked in its present form? Has it been changed recently? How often does the problem occur?
  - What release of the operating system are you using? Has it, your security system, communications protocol, or front-end software changed?
  - Is this problem reproducible? If so, how?
Have you tried to reproduce your problem in the simplest form possible? For example, if you are having problems joining two data sources, have you tried executing a query containing just the code to access the data source?

Do you have a trace file?

How is the problem affecting your business? Is it halting development or production? Do you just have questions about functionality or documentation?

**User Feedback**

In an effort to produce effective documentation, the Technical Content Management staff welcomes your opinions regarding this document. You can contact us through our website [http://documentation.informationbuilders.com/connections.asp](http://documentation.informationbuilders.com/connections.asp).

Thank you, in advance, for your comments.

**Information Builders Consulting and Training**

Interested in training? Information Builders Education Department offers a wide variety of training courses for this and other Information Builders products.

For information on course descriptions, locations, and dates, or to register for classes, visit our website ([http://education.informationbuilders.com](http://education.informationbuilders.com)) or call (800) 969-INFO to speak to an Education Representative.
Document Composer enables you to design reports, coordinate layouts, and distribute layouts, made up of multiple reports and graphs. These can be done in a single document.

You can position reports and graphs anywhere on a single page or combine a series of layouts within a single document.

When creating compound reports from Document Composer, PDF, HTML, active report, PowerPoint, Excel, Excel 2007, active PDF, active Flash, and User output formats are available.

**Note:** Although the output format list displays HTML, the report output format created in the request is actually DHTML (Web Document).

This section describes how to create a layout in the local development environment. For information on creating a user interface in Managed Reporting, see your Managed Reporting documentation.

**In this chapter:**
- Uses for Document Composer
- Getting Started With Document Composer

**Uses for Document Composer**

When creating a document with Document Composer, you can:

- Design complex reports.
- Build compound reports.
- Coordinate and distribute various free-form layouts, made up of multiple reports and graphs, in a single output file.
- Precisely position reports and graphs anywhere on a single page or combine a series of layouts.

**Note:** The technology used during design time and run time is different. This may result in the run-time document not looking exactly the same as it does during design time.
Link reports together by a common sort field so that multiple reports and graphs can be burst into individual page layouts.

Getting Started With Document Composer

You can create compound reports and coordinated compound reports in one integrated process with Document Composer.

Procedure: How to Access Document Composer From the Procedures Folder

1. With the Procedures folder highlighted, select New from the File menu, then select Procedure.

   The Add Procedure dialog box opens.

2. Enter a name for the new procedure in the File name field.
3. Select Composer from the Create with drop-down list.
4. Click Open.

   Document Composer opens.

Procedure: How to Access Document Composer From QuickLinks

1. Select QuickLinks from the View menu in the Developer Studio Explorer.

   Note: QuickLinks is turned off by default.
2. From the QuickLinks dialog box, click Coordinate reports and graphs.

The New Procedure File dialog box opens.

3. Enter a name for the new procedure in the File name field and click Create.

Document Composer opens.

**Note:** Document Composer is the default for the Coordinate reports and graphs QuickLink.

**Reference:**  Document Composer Windows and Toolbars

When you open Document Composer, it appears similar to the following image:
The main elements of Document Composer are:

**Menu Bar**
Displays menus for Document Composer.

**Developer Studio Toolbar**
Displays tool buttons, such as Open and Run.

**Standard Toolbar**
Displays buttons, such as Copy and Paste, that enable you to edit the layout.

**Components Toolbar**
Displays buttons that insert objects, such as Reports and Graphs, into the layout.

**Positioning Toolbar**
Displays buttons that align objects and control the appearance of the layout.

**Formatting Toolbar**
Displays buttons that format and align text when using a text element in the layout.

**Properties Tab (Properties Window)**
Displays the properties of objects in the layout.

**Thumbnails Tab (Properties Window)**
Enables you to view thumbnails of each page in the layout. Thumbnails work similarly to thumbnails in Adobe® PDF, in that they enable you to scroll to different pages. Select an image from the Thumbnails tab to jump to the selected object in the layout. You may also refresh the Thumbnails tab, enlarge or reduce the thumbnails, and select pages to be reordered directly from the Thumbnails tab. For more information, see *Moving Pages With the Thumbnails Tab* on page 42.

**Reference: Standard Toolbar**
The Standard toolbar contains the following buttons:
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Save Icon](image) | Saves the existing procedure (.fex) and output files to the current project. This button is unavailable once the layout is saved and no new changes have been made. When a change has been made to the layout, the Save button is active until the report is saved again.  
**Note:** The Save icon drop-down list offers options to Save Document As and Save Current Document As. For details, see *How to Save a Page Master in Document Composer* on page 48 and *How to Save an Individual Page Layout in Document Composer* on page 87.  
Save Document As and Save Current Page As will be grayed out and unavailable when Document Composer is accessed through HTML Composer. |
| ![Cut Icon](image) | Removes the highlighted object(s) and saves it to the clipboard. |
| ![Copy Icon](image) | Copies the highlighted object(s) to the clipboard. |
| ![Paste Icon](image) | Pastes the object(s) to the specified location. |
| ![Delete Icon](image) | Deletes the highlighted object(s). |
| ![Reset Icon](image) | Resets the layout by reversing the last action performed. |
| ![Repeat Icon](image) | Repeats the last action performed. |
| ![Refresh Icon](image) | The Refresh All option enables you to view any edits or changes that you have made to your document. Refresh All reloads all pages and reruns the reports and graphs in Design View.  
**Note:** Refresh All also shows changes made to reports and graphs that are referenced in your document. |
**Reference: Components Toolbar**

The Components toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Icon" /></td>
<td>Inserts a report object into the layout.</td>
</tr>
<tr>
<td><img src="image2" alt="Icon" /></td>
<td>Inserts a graph object into the layout.</td>
</tr>
<tr>
<td><img src="image3" alt="Icon" /></td>
<td>Inserts a placeholder for an image. You can multiselect image files from the Get source files dialog box. The files will be cascaded on the canvas and can then be moved as required.</td>
</tr>
<tr>
<td><img src="image4" alt="Icon" /></td>
<td>Inserts text.</td>
</tr>
<tr>
<td><img src="image5" alt="Icon" /></td>
<td>Inserts a line.</td>
</tr>
<tr>
<td><img src="image6" alt="Icon" /></td>
<td>Inserts a text box into an active report, active Flash file, or active PDF file.</td>
</tr>
<tr>
<td><img src="image7" alt="Icon" /></td>
<td>Inserts a drop-down list box into an active report, active Flash file, or active PDF file.</td>
</tr>
<tr>
<td><img src="image8" alt="Icon" /></td>
<td>Inserts a list box into an active report, active Flash file, or active PDF file.</td>
</tr>
<tr>
<td><img src="image9" alt="Icon" /></td>
<td>Inserts a check box into an active report, active Flash file, or active PDF file.</td>
</tr>
<tr>
<td><img src="image10" alt="Icon" /></td>
<td>Inserts a radio button into an active report, active Flash file, or active PDF file.</td>
</tr>
</tbody>
</table>
**Reference: Positioning Toolbar**

The Positioning toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="grid button" /></td>
<td>Toggles between displaying and hiding the grid.</td>
</tr>
<tr>
<td><img src="image" alt="align left button" /></td>
<td>Aligns objects to the left.</td>
</tr>
<tr>
<td><img src="image" alt="align right button" /></td>
<td>Aligns objects to the right.</td>
</tr>
<tr>
<td><img src="image" alt="align top button" /></td>
<td>Aligns objects by the top of the highest selected object.</td>
</tr>
<tr>
<td><img src="image" alt="align bottom button" /></td>
<td>Aligns objects by the bottom of the lowest selected object.</td>
</tr>
<tr>
<td><img src="image" alt="align center horizontally button" /></td>
<td>Aligns objects at the horizontal center point of the canvas in Design View.</td>
</tr>
<tr>
<td><img src="image" alt="align center vertically button" /></td>
<td>Aligns objects at their vertical center (or middle) point of the canvas in Design View.</td>
</tr>
<tr>
<td><img src="image" alt="equal width button" /></td>
<td>Makes two or more objects the same width.</td>
</tr>
<tr>
<td><img src="image" alt="equal height button" /></td>
<td>Makes two or more objects the same height.</td>
</tr>
<tr>
<td><img src="image" alt="equal size button" /></td>
<td>Makes two or more objects the same size.</td>
</tr>
<tr>
<td><img src="image" alt="align center button" /></td>
<td>Aligns objects to the center of the canvas in Design View.</td>
</tr>
</tbody>
</table>

**Note:** You can also select any of the align options from the drop-down list.

<p>| <img src="image" alt="link button" /> | Sets the relationship between selected objects. |</p>
<table>
<thead>
<tr>
<th><strong>Button</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Image" /></td>
<td>Breaks the relationship between objects.</td>
</tr>
<tr>
<td><img src="image2" alt="Image" /></td>
<td>Shows or hides the arrow indicating relationships between objects.</td>
</tr>
<tr>
<td><img src="image3" alt="Image" /></td>
<td>Creates a new page layout.</td>
</tr>
<tr>
<td><img src="image4" alt="Image" /></td>
<td>Moves up one level to the next page (for multiple page layouts).</td>
</tr>
<tr>
<td><img src="image5" alt="Image" /></td>
<td>Moves down one level to the next page (for multiple page layouts).</td>
</tr>
<tr>
<td><img src="image6" alt="Image" /></td>
<td>Adds a control to a chain. Each time a selection is made, all chained controls will be dynamically updated. <strong>Note:</strong> The Add to current chain button is available when controls are multi-selected on the canvas. This button is disabled if you multi-select controls that are already in a chain.</td>
</tr>
<tr>
<td><img src="image7" alt="Image" /></td>
<td>Removes a control from a chain. <strong>Note:</strong> The Remove from current chain button is available when controls are multi-selected on the canvas. This button is disabled for the first control in a chain but is enabled for all others.</td>
</tr>
<tr>
<td><img src="image8" alt="Image" /></td>
<td>Shows the chaining order of all controls that are currently part of a chain.</td>
</tr>
</tbody>
</table>

For more information about positioning objects, see [Controlling the Overflow and Relative Positioning of Objects](#) on page 51.

**Reference:** **Formatting Toolbar**

The Formatting toolbar contains options that can be applied to individual strings of text, as well as to the entire text element, with the exception of the alignment options. The alignment options can only be applied to the text element.
For more information about using text elements, see *Formatting Text in Document Composer* on page 93.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>Applies bold formatting to the text.</td>
</tr>
<tr>
<td>I</td>
<td>Applies italic formatting to the text.</td>
</tr>
<tr>
<td>U</td>
<td>Applies underline formatting to the text.</td>
</tr>
<tr>
<td>S</td>
<td>Applies superscript typography to the text.</td>
</tr>
<tr>
<td>A</td>
<td>Font style opens the Font dialog box where you can set the Font, Font Style, Size, Color, and Effect of the text.</td>
</tr>
<tr>
<td>L</td>
<td>Aligns the text element to the left.</td>
</tr>
<tr>
<td>C</td>
<td>Aligns the text element to the center.</td>
</tr>
<tr>
<td>R</td>
<td>Aligns the text element to the right.</td>
</tr>
<tr>
<td>F</td>
<td>Aligns the text to fill the width of the text element.</td>
</tr>
</tbody>
</table>
**Reference: Compound Document Properties Window**

The following image is the Properties window for Compound documents:

![Compound Document Properties Window](image)

The Compound Document Properties window contains options that control the properties of your report and reporting objects. The properties are:

**Bookmarks**

Determines whether the compound document will have bookmarks. The options are Off (default) and On.

**Coordinate report**

Determines whether the compound document will be bursted by the primary sort value. The options are Off (default) and On.

**Output format**

Sets the output format for the document. The options are:

- PDF (default)
- HTML
- PowerPoint
- active report
- Excel
Page color

Sets the background color of the page. Opens the Color Picker dialog box where you can either choose from preset colors or set your own custom color.

**Note:** This option is only available for active report and active Flash output formats. The option will be hidden in the Properties window until you select either active report or active Flash from the Output format property.

Page margin: Bottom

Determines the bottom margin of the page. The default value is 0.5.

Page margin: Left

Determines the left margin of the page. The default value is 0.5.

Page margin: Right

Determines the right margin of the page. The default value is 0.5.

Page margin: Top

Determines the top margin of the page. The default value is 0.5.

Page orientation

Determines the orientation of the page. The options are Portrait (default) and Landscape.

Page size

Determines the size of the page. The options are:

- Letter
- Tabloid
- Ledger
- Legal
- PowerPoint Slide
- Statement
- Executive
- A3
- A4
- A5
- B4
- B5
- CUSTOM1
- D
- E
- Folio
- Quarto
- 10 x 14
- 11 x 17
- U.S. Standard Fanfold
- German Standard Fanfold
- German Legal Fanfold
- Envelope #9
- Envelope #10
- Envelope #11
- Envelope #12
- Envelope #14
- Note
- Envelope DL
- Envelope C5
- Envelope C3
- Envelope C4
- Envelope C65
- Envelope C6
- Envelope B4
- Envelope B5
- Envelope B6
- Envelope Monarch

**Note:** When using a Dashboard Bar, it is advised that you use Page size options D or E. If you use other Page size options, text in the Dashboard Bar may overlap.

**Units**

Sets the units of measurement for the development environment. The options are Inches (default), Centimeters, and Points.

These properties adhere to Microsoft standards. For more information on Microsoft object properties, see your Microsoft documentation.
Creating Compound Reports

You may create a compound layout report or a coordinated compound report in Document Composer. This section describes how to create compound reports, the output formats for compound reports, and how to add reporting objects to a compound report.

In this chapter:

- Creating a Compound Layout Report
- Output Formats for Compound Reports
- Adding a Reporting Object to a Compound Report

Creating a Compound Layout Report

There are multiple types of compound reports that can be built in Document Composer:

- **Compound Layout Report.** Allows absolute positioning of reports and graphs. This is the default.

  **Note:** The technology used during design time and run time is different. This may result in the run-time document not looking exactly the same as it does during design time.

- **Coordinated Compound Layout.** Is coordinated so that all reports and graphs that contain a common sort field are burst into separate page layouts. Each value for the first sort field displays on a separate page.

A compound layout report is comprised of individual component reports or graphs, either embedded or external. Reports and graphs can be positioned anywhere on the page. When you create a report or open Document Composer, the Properties window shows the compound document properties for the compound layout report.

You can create pre-process code that applies to all objects added to a document. For example, if a report or graph within your document requires the joining of two tables, you can create pre-process code that joins those two tables. This join can then be used by any object in the document and any items following the pre-process code.

In addition, you can create post-process code that runs after the document is run. This can be used in conjunction with pre-process code. For example, using pre-process code, you could create a join. You could then use the post-process code to clear that join.
Procedure: How to Create Pre-process Code for a Document

While in a document:

1. From the **Insert** menu, click **Pre-process code**.
   
   The procedure viewer window opens.
   
   Here, you can create the pre-process code that the document will use. A join is being used in this example.

2. Click the component connector and select **Join**.

3. Join the videotrk and movies Master Files.

4. Save and close the Join.

5. Close the procedure viewer.

6. In your document, create a report frame.

7. Double-click the report frame to open the procedure viewer.

   **Note:**

   - Normally, double-clicking a report frame prompts you to select a Master File for creating a report. However, when pre-process code or post-process code is present, the procedure viewer opens instead.
   
   - The pre-process code is displayed, with the last block being a comment that states:

     \[
     \text{Do not move, remove, or modify. Pre-process code above.}
     \]

     This comment separates pre-process code from component code. Adding component blocks before this comment, or editing what is already there, modifies the pre-process code. Adding blocks after this comment affects the component code.

8. Click the component connector after the pre-process code and select **Report**.

   Report Painter opens.

   The pre-process code joined the videotrk and movies Master Files, allowing you to use data from both in your report.
**Procedure:** How to Create Post-process Code for a Document

While in a document:

1. From the *Insert* menu, click *Post-process code*.

   The procedure viewer window opens.

   Here, you can create the post-process code that the document will use. A join clear is being used in this example.

   **Note:** Any pre-process code you created is shown in the procedure viewer. Do not modify or delete the pre-process code when creating or modifying post-process code.

2. Click the component connector after all other procedure components and select *Join*.

3. Clear all joins.

4. Save and close the Join.

5. Close the procedure viewer.

   After the document runs, the post-process code will clear all joins. When combined with pre-processing code, you can create the joins before the document is run and clear the joins after.

**Procedure:** How to Create a Report Frame

Whether you are using an embedded or external report, you must first create the report frame. To create the report frame:

1. Click the *Report* icon.

   Your cursor becomes a crosshair.

2. Click and drag the crosshair to create a report frame.

3. Adjust the report frame to the size you want.

**Procedure:** How to Add an Embedded Report

You can use Document Composer to add embedded reports by either creating a report or importing an existing procedure.
Creating a Compound Layout Report

- To create an embedded report, double-click the report frame.
- To import an embedded report, right-click the report frame and select *Import existing report*.

**Procedure:** How to Add an External Report

External reports are reports that are created and saved outside of Document Composer. To reference (or add) an external report, right-click the report frame and select *Reference existing procedure*. An EX command will be used to execute the component procedure at run time.

Layering Objects

You can layer objects that are added to the page layout by using the object context menu shown in the following image:

The options are:

- **Bring to front.** Moves an object to the front so that it is stacked on top of every other object it overlaps with.
- **Send to back.** Moves an object to the back so that it is stacked below every other object it overlaps with.
- **Move forward.** Moves an object forward one position in the stacking z-order.
Move backward. Moves an object backwards one position in the stacking z-order.

When using any of these commands, the stacking order of the object will change. This is reflected in the z-index property in the Properties window, The z-index is the stacking order of a specific object.

Reference: Adding External Reports

- Reports must be saved with PDF output format specified in the procedure. Only the first report in the procedure must be in PDF format; the other report formats are ignored.

- Graphs must be saved with a HOLD command, and specified as a format of SVG, GIF, or JPG. SVG will be the most common format since it produces the highest quality graphs. When creating new graphs from within the Graph tool, SVG and HOLD should automatically be selected.

The following graph image output formats are supported in Document Composer:

- When active report is the output format, no graph outputs are supported.
- When PDF is the output format, SVG, GIF, and JPEG are supported.
- When Excel or Excel 2007 is the output format, GIF and JPEG are supported.
- When PowerPoint is the output format, SVG, GIF, and JPEG are supported.

Procedure: How to Create a Coordinated Compound Layout

A coordinated compound layout coordinates all reports and graphs from the document with a common sort field. The coordinated report is burst into separate page layouts at run time, where each value for the first sort field displays on a separate page.

1. From the Properties window in Document Composer, select Compound document from the Properties list.
2. Select On from the Coordinate report properties field.

Note: Coordinate report is set to Off by default.

3. Save and run the document.
Output Formats for Compound Reports

When creating compound reports from Document Composer, PDF, HTML, active report, PowerPoint, Excel, Excel 2007, active PDF, and active Flash output formats are available.

You can also set the output format to User, which will allow the user to define an output format at run time. For more information on the User output format, see How to Set Output Format to User on page 33.

There are several requirements and restrictions when using these output formats with coordinated compound reports:

- In active report and active Flash output formats:
  - Multiple reports and charts are combined into one document.
  - You must have at least one report object.
  - LINE, IMAGE, and TEXT objects are not supported in the document.
  - Chart objects are static images that cannot be altered using active report and active Flash menu options.
Excel:
- Combines multiple reports as different sheets in a workbook.
- LINE, IMAGE, and TEXT objects are not supported in the document.

Power Point:
- Combines multiple reports and charts in a single slide.
- You may embed the output into pre-existing PowerPoint templates.
- LINE, IMAGE, and TEXT objects are supported.

**Procedure: How to Select Output Formats in Document Composer**

1. From the Properties window in Document Composer, select *Compound document* from the Properties list.
2. In the *Output format* field, use the drop-down list to select an output format.

**Procedure: How to Set Output Format to User**

You can set the output format to User, which will allow the user to define an output format at run time.

1. From the Properties window in Document Composer, select *Compound document* from the Properties list.
2. In the *Output format* field, use the drop-down list to select *User*.
3. From the File menu or the toolbar, select *Run*.
Your web browser opens and asks you to specify the type of display output, as shown in the following image:

Using PowerPoint Templates With Compound Documents

When PowerPoint is set as the Compound document output format, you may embed the compound output into a pre-existing PowerPoint template.

**Note:** PowerPoint templates are not supported if your report is coordinated. If a coordinate has been selected, PPT templates will be disabled.

**Procedure:** How to Use PowerPoint Templates With Compound Documents

To embed a compound report in a PowerPoint template:

1. Save the pre-existing third-party PowerPoint template in Microsoft Office Web Archive or Single File Web Page (.mht) format in a WebFOCUS Reporting Server application directory, as shown in the image below.
2. In Document Composer, select the Template name ellipsis button from the Compound document property window.

**Note:** The Template name property is only available when the compound document output format is PowerPoint.

The Get source file dialog box opens.

3. Select the PowerPoint template from the WebFOCUS Reporting Server application directory and click Open.

4. Select the placeholder slide of the template in the Slide number property field of the Compound document property window.

**Note:** The Slide number property is only available when the compound document output format is PowerPoint.

5. Save and run the document.

The output is embedded to the assigned slide in the PowerPoint template.

**Adding a Reporting Object to a Compound Report**

The following reporting objects are available for creating a report in Document Composer:

- Reports
Adding a Reporting Object to a Compound Report

- Graphs
- Formatting Objects:
  - Images
  - Text
  - Lines
  - Boxes

**Note:**
- If you want to add a formatting object to a page layout by itself, you must include a report that generates no visible output.
- Adding a reporting object that contains a Precision Report, created with the Precision Report tool in Report Painter, is not supported in Document Composer.
- For images, the Pop-up description option allows for you to enter ALT text, which can be read by a screen reading program such as JAWS®.

**Reference:  Restrictions for Graphs Used in the Document Composer**
- Graphs must contain a BY and an ACROSS field or two BY fields.
- Graphs must be saved with a HOLD command. If there are multiple graphs per sort field, the file name must be no longer than four characters. If there is only one graph per sort field, the file name can be up to eight characters in length.
- Graphs must be specified as a format of SVG, GIF, or JPG.
- If a graph contains WebFOCUS Titles (Page Heading, Page Footing), they are automatically removed from the graph, unless you select to embed text in the image.
There are several methods available for viewing and loading pages in the Document Composer:

- On demand viewing.
- Viewing simulated or live data.
- Positioning objects and keyboard shortcuts.
- Reordering pages directly from the Thumbnails tab.

**In this chapter:**

- On Demand Viewing in Document Composer
- Viewing Simulated or Live Data in Document Composer
- Moving Pages With the Thumbnails Tab
- Positioning Objects and Keyboard Shortcuts

---

**On Demand Viewing in Document Composer**

On demand viewing changes the way pages are loaded in Document Composer. Previously, Document Composer loaded all pages, reports, and graphs into memory, enabling you to scroll to any element in the tool.

Currently, only the page(s) that are visible in the Design View are loaded into memory. For example, if a document has three page layouts and only the first is visible, only those reports and graphs are executed. This is done by selecting either simulated or live data from the Document tab of the Developer Studio Options dialog box. For more information about these options, see *Viewing Simulated or Live Data in Document Composer* on page 38.

As you scroll to the next page, the content of the page, reports, and graphs are loaded as they come into view. This makes the page load faster and take up less virtual memory on your machine.

In addition, there is a Refresh All option which enables you to view any edits or changes that you made to your document. Refresh All reloads all pages and reruns the reports and graphs in Design View.
Viewing Simulated or Live Data in Document Composer

When previewing the report and graph data in Document Composer, you may view the data in simulated or live mode.

**Note:** These preview settings are only available in the Design View of Document Composer and do not affect how data is shown at run time.

Previewing simulated data sends a request to the reporting server that gathers formatting information from the Master File. The database is not accessed, but rather, mock data is used to visually represent the report. The formatting and styling options applied to the report are shown when viewing simulated data.

Previewing live data sends a request to the reporting server and to the database. This is done in order to get a snapshot of the actual data in the report or graph. You may select the number of records that appear in the report when previewing live data. You may also set the read limit and record limit to control the number of records accessed in the database.

**Procedure:** How to Preview Reports and Graphs Using Simulated Data

1. In Document Composer, select *Options* from the Window menu.
   The Developer Studio Options dialog box opens.
2. Select the *Document* tab.
3. From the Preview settings option, select *Simulated Data*.
   **Note:** Live Data is selected by default.
4. Click *OK* to close the Developer Studio Options dialog box.
To refresh a simulated data component, right-click the simulated data component and select *Refresh with live data* from the context menu, as shown in the following image:

---

**Procedure:** How to Preview Reports and Graphs Using Live Data

1. In Document Composer, select *Options* from the Window menu.
   
   The Developer Studio Options dialog box opens.

2. From the Preview settings option, select *Live Data*.

   **Note:** Live Data is selected by default.

3. Use the spin buttons located to the right of the Record limit for reports field to increase or decrease the number of records shown in the report.

   or

   Position the cursor in the Record limit for reports input box and type a number.

   **Note:** The default record limit value for the report is 500.

4. Click *OK* to close the Developer Studio Options dialog box.
Reference: Developer Studio Options Document Tab

The following image is the Developer Studio Options Document tab:

The following options are available from the Developer Studio Options Document tab.

**Grid Settings**

Settings for Grid include:

- **Show Grid**
  
  Displays a grid. If this is not selected, the grid is turned off for all layouts.

- **Snap to Grid**
  
  Causes objects in the layout to snap to grid lines when being positioned. For detailed positioning, deselect this option.

- **Width**
  
  The width of the grid in pixels.
Height

The height of the grid in pixels.

Preview Settings

Preview settings include:

Report and Graph Preview

Previews report and graph data in the Design View. If checked, additional options are available (Simulated Data or Live Data).

Note: This option is selected by default.

If unchecked, icons are used to represent the area in the Design View for reports and graphs. This is the fastest method of loading reports since no requests are made to the server.

Simulated Data

Selecting to preview simulated data sends a request to the reporting server that gathers formatting information from the Master File. The database is not accessed, and mock data is used to visually represent the report.

Note: This option is only available when previewing reports and graphs.

Live Data

Selecting to preview live data sends a request to the reporting server, and to the database, to get a snapshot of the actual data in the report. This is the default value.

Note: This option is only available when previewing reports and graphs.

Record limit for reports

Enables you to limit the number of records used to gather data for previewing the report in live data mode. For example, if you set 250 as the record limit for the report, then 250 rows of data are gathered for the report results. The default value for the record limit is 500.

Note: This option is only available if the Live Data option is selected.
Use Prefix

Selecting *Use Prefix* will take any FOCUS syntax in the input box and apply it to the components at preview time. For example, SQL SQLORA SET OPTIMIZATION OFF. Since the settings are saved for all documents, you can select the Use Prefix option to indicate to the tool whether or not to use the prefix for the specific document.

Refresh thumbnails every

Indicates how often (in seconds) to refresh the thumbnails.

Moving Pages With the Thumbnails Tab

You may select pages to be reordered directly from the Thumbnails tab of Document Composer. The Thumbnails tab is available from the Properties window of Document Composer.

Moving pages on the Thumbnails tab applies to page layouts only. Although each page of the layout appears on the Thumbnails tab, the Page Master and Table of Contents (TOC) page cannot be moved, nor can a selected page layout be moved before a Page Master or TOC page.

**Procedure: How to Move Pages With the Thumbnails Tab**

1. Create or open a report with multiple page layouts in Document Composer.
2. Click the *Thumbnails* tab of the Properties window to view thumbnails of each page in the layout.
   
   **Tip:** Select *Properties* from the View menu to open the Properties window.

   Each of the thumbnails in the document are numbered in page order.
3. Select the thumbnail image of the page layout that you are moving.
   
   **Note:** If selecting multiple page layouts to be moved, press the Shift key and left-click the thumbnail images.

   The selected page appears in Design View with the number of the thumbnail page highlighted.
3. Viewing Pages in Document Composer

The following image shows the Thumbnails tab of Document Composer with *Page layout 1* selected:

4. Left-click and drag the selected thumbnail image in the gray space between or after pages, and release the mouse button.

![Thumbnail image](image)

**Note:** You may not insert a page layout before the Page Master or Table of Contents (TOC) page. Additionally, if you move a page that has an overflow page, the overflow page moves with its parent automatically.

The page layout is moved in the document, as shown with the location of the thumbnail image. Note how the page numbers are updated for the thumbnail images.

5. To move the thumbnail image back to its original location, select *Undo* from the Edit menu of the Document Composer.
The following images show the process of moving a selected page layout on the Thumbnails tab of Document Composer:

1. Select the thumbnail image for the page layout, left-click, and drag.

2. Drag the selected page in the gray space between pages, and release the mouse button.
Positioning Objects and Keyboard Shortcuts

Align positioning options enable you to multi-select objects and easily position them relative to one another. These options are available from the Positioning toolbar in Document Composer.

**Note:** These options only apply to positioning objects in the Design View of Document Composer.
The following Align options appear on the Positioning Toolbar:

<table>
<thead>
<tr>
<th>Object</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>The Align to center of page positioning option aligns objects at the horizontal center point of the canvas in Design View.</td>
</tr>
<tr>
<td>☑️</td>
<td>The Align to middle of page positioning option aligns objects at their vertical center (or middle) point of the canvas in Design View.</td>
</tr>
<tr>
<td>☑️</td>
<td>The Align to left edge positioning option aligns objects to the left margin of the bounding rectangle in Design View.</td>
</tr>
<tr>
<td>☑️</td>
<td>The Align to right edge positioning option aligns objects to the right margin of the bounding rectangle in Design View.</td>
</tr>
<tr>
<td>☑️</td>
<td>The Align to top edge positioning option aligns objects to the top margin of the bounding rectangle in Design View.</td>
</tr>
<tr>
<td>☑️</td>
<td>The Align to bottom edge positioning option aligns objects to the bottom margin of the bounding rectangle in Design View.</td>
</tr>
<tr>
<td>☑️</td>
<td>All options under this icon position elements relative to the page.</td>
</tr>
<tr>
<td>☑️</td>
<td>Changes the width of the first selected object to the width of the second selected object.</td>
</tr>
<tr>
<td>☑️</td>
<td>Changes the height of the first selected object to the height of the second selected object.</td>
</tr>
<tr>
<td>☑️</td>
<td>Changes the height and width of the first selected object to the height and width of the second selected object.</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

The following keyboard shortcuts are available in Document Composer:

- For positioning objects relative to the page, press the Alt key and select an Align option button from the Positioning toolbar.

- For page related shortcuts, you may use the Home and End keys to quickly navigate to the beginning and end of the document.
A Page Master is a page that can be added in the Design View where you can add and edit repeating elements, such as the company logo or page numbers. Any element placed on the Page Master repeats on every page in the resulting report.

In this chapter:

- Creating, Saving, and Editing Page Masters in Document Composer
- Using an Existing Page Master in Another Document

Creating, Saving, and Editing Page Masters in Document Composer

Using Page Masters enables you to create a document, or a page, that maintains images, drawing objects, text, and pages. You may reuse an existing Page Master from another document.

Note: The elements added to the Page Master appear in the Design View of Document Composer and do not affect the data shown at run time.

Page Master elements do not automatically resize and position for various page orientations throughout the document. For documents requiring mixed page orientations, each page layout can be defined with its own orientation. For more information, see the Creating Reports With WebFOCUS Language manual.

The following image is an example of the Page Master view in Document Composer:
Procedure: How to Create a Page Master in Document Composer

1. From the Explorer view of Developer Studio, with the Procedures folder highlighted, select New from the File menu, then select Procedure.
   The Add Procedure dialog box opens.
2. Enter a name for the new procedure in the File name field.
3. Select Composer from the Create with drop-down list.
4. Click Open.
   Document Composer opens.
5. Select Add Page Master Layout from the Insert menu.
   or
   Select this option from the New Page Layout button on the Positioning toolbar.
   The Page Master appears in the Design View.
6. Add elements and set properties for the elements in the Design View.

Note: Only Text, Images, and Lines can be added to the Page Master.

Procedure: How to Save a Page Master in Document Composer

Once the elements have been added, you may save the Page Master.

Note: Saving the Page Master is optional.

1. Select Save Document As from the File menu to save the Page Master.
   or
   Select this option from the Save button on the Standard toolbar.
2. Type in a file name for the Page Master.

Note: The Specify Name dialog box appears if you select an existing procedure name (.fex), asking you if you want to replace the file.
3. Click OK to close the Save As dialog.
   
The entire document, including the Page Master, is saved as a procedure file (.fex).

**Note:** The Page Master is inserted as the second page in the document and all repeating objects are applied to the document.

**Reference: Saving Page Masters**

The following rules apply when saving Page Masters in Document Composer:

- If you are using the Save option, the Page Master is saved under the open procedure file name.
- A Page Master can be saved to any location: local desktop, application directory, or Managed Reporting Domain.
- All text, images, drawing objects (including properties), and document level styling are retained.
- If you are using the Save Document As option, the Specify Name dialog box appears if you select an existing procedure name (.fex), asking you if you want to replace the file.

**Reference: Editing Objects in the Page Master**

The following rules apply when editing the Page Master in Document Composer:

- Any object placed on the Page Master also shows up in all other layouts in the Design View. Objects can be added, edited, or removed from the Page Master. They cannot be edited from any other page layout.
- When editing or removing objects on the Page Master, select Refresh Page Master from the Standard toolbar to view the changes to the Page Master.

**Using an Existing Page Master in Another Document**

Using an existing Page Master is comparable to using a Save As option, as it saves the existing report and page layout so that you can apply it to another report. When adding an existing Page Master, you may choose to overwrite the current Page Master or merge the two Page Masters.

**Note:** These options only appear when a Page Master already exists in an open document.

**Procedure: How to Use an Existing Page Master in Another Document**

To add a previously saved Page Master to an open document:
1. Select *Add Existing Page Layout* from the Insert menu.

   or

   Select this option from the New Page Layout button on the Positioning toolbar.

2. Select the procedure file (.fex) of the layout template that contains the previously saved Page Master.

   **Note:** The Page Master is included as the second page of a Page Layout template.

3. Click *Open*.

   **Note:** If a Page Master has already been added to the document, a message appears stating that a Page Master already exists in the current layout. You may replace the Page Master, merge the two, or ignore the Page Master.

4. Click *Yes* to replace the existing Page Master with the new one.

   Click *No* to merge the two Page Masters.

   Click *Cancel* to use the existing Page Master and ignore the Page Master from the Page Layout template.

For details about importing an existing Page Layout template, see *Using Page Layouts in Document Composer* on page 87.
You may control the overflow and relative (vertical) positioning of reports and graphs in coordinated compound documents. This is done so that reports fill the entire page, as well as maintain their relative position in the document.

Overflow is defined as the area of a report that exceeds its defined space in the page layout. For example, a multi-page report and a graph can both be added to a single page layout with the graph positioned beneath the report. The report can flow or fill the page and the graph can be relatively positioned to the report, so it is placed at the end of the document following the complete rendering of the report.

Overflow and positioning options are available from the Properties window and from the Positioning toolbar in Document Composer.

**In this chapter:**

- Setting Overflow Options in Document Composer
- Using Fixed Overflow in Document Composer
- Using Flowing Overflow in Document Composer
- Setting a Relative Position Between Objects in Document Composer
- Adding Different Headers and Footers on an Overflow Page
Setting Overflow Options in Document Composer

When executing a report, the area that flows outside of the original bounding rectangle is considered the overflow. The following image is an example of the bounding rectangle in the Design View of Document Composer:

![Bounding rectangle example](image)

You can set the size and overflow of a report object to control the overflow at run time. Fixed and flowing overflow options are available through the Properties window.

- **Fixed.** The report is confined to the dimensions of its (Design View) bounding rectangle at run time, and continues to output on multiple pages within the same fixed dimensions until all of the data is shown.

- **Flowing.** The report output begins at the top of the page and fills the page (and subsequent pages) with the report results until the data is complete. Flow margins are available to define the starting and stopping point on each page. Flow margins enable reports to automatically fill an area of the page while enabling other objects, such as repeating images and text (headers and footers), to be shown and not overlapped by the flowing report.

**Note:** These options only apply to report objects. There are no size and overflow properties for graphs, images, text, or lines.
The following image is an example of a report with fixed overflow in the Design View:
The following image is the report output with fixed overflow. The PDF Pages view shows how the report output maintains the size and position of the report object in Design View.
The following image is an example of a report with flowing overflow in the Design View:
Using Fixed Overflow in Document Composer

Reports using fixed overflow maintain the size and position of the report object from Design View in the report output. Fixed is the default overflow behavior for all reports.

You may customize and maintain the fixed overflow of the report output by adjusting the size and position of the report on a special overflow page.

**Procedure:** How to Customize the Overflow for a Fixed Report

The following is an example of how to customize the Overflow for a Fixed report.

   
   The Properties window shows the available properties for the selected object.

2. Select **Fixed** from the Size and Overflow drop-down list.
Note: Fixed is the default selection. If Not Set is selected, Fixed is used as the default.

3. Right-click the fixed report in the Design View and select Customize Fixed Overflow.

The overflow page is added after the page layout in the Design View, displaying a copy of the fixed component (with the original size and position) from the page layout. Scroll down in the Design View until you see the overflow page.

4. Resize the report to fill the page. You may also optionally reposition the report overflow.

5. Run the report.

Note: If the document contains multiple fixed reports, the report output maintains the same size and position as the report objects in Design View, as shown in the image below.

Note: If the document contains a fixed report and a graph, and the report is broken up around the graph object, you must set the relationship between the graph and the report if you want the graph to follow the report. For more information about setting relationships, see How to Relate Surrounding Objects to a Report on page 63.

Using Flowing Overflow in Document Composer

Reports using flowing overflow begin the report output at the top of the page and fill the page with the report results. When Flowing is selected, flow margins are available which enable you to adjust the page layout so that flowing objects fill the page, or a selected portion of the page.
**Procedure: How to Set the Flowing Report Property**

   
   The Properties window shows the available properties for the selected object.
   
2. Select *Flowing* from the Size and Overflow drop-down list.
   
   **Note:** Repeat this step for any surrounding report objects to prevent the overlapping of reports and graphs at run time.

**Tip:** When set to Flowing, flow margins are available for the page layout. These margins further enable you to adjust the page so that the report fills each page between the flow margins. For more information about flow margins, see *How to Set Flow Margins for the Page Layout* on page 60.

3. Run the document.
Note: If the document contains multiple flowing reports, the reports may overlap at run time. If you want one report to run until completion before the next report begins, you must set the relationship between the reports. For more information about setting relationships, see *How to Relate Surrounding Objects to a Report* on page 63.
Note: If the document contains a flowing report and a graph, the graph may overlap the report at run time. If you want the report to run until completion before the graph begins, you must set the relationship between the graph and the report. For more information, see *How to Relate Surrounding Objects to a Report* on page 63.

**Procedure: How to Set Flow Margins for the Page Layout**

When using Flowing overflow, each page layout has flow margins. Flow margins are set through the top and bottom margins. Flowing reports utilize flow margins to ensure all reports fill the page, or the selected portion of the page. The header and footer information is preserved in the output.

**Note:** Flow margins are not available for Fixed overflow.

1. In Document Composer, select a page layout from the Design View.

   **Note:** Ensure that the report object is set to Flowing overflow. For more information about flowing reports, see *How to Set the Flowing Report Property* on page 58.

2. From the Properties window, type in the *flow margin bottom* value.

   The flow margin bottom value sets the ending vertical coordinate where a flowing report ends on each page.
3. From the Properties window, type in the *flow margin top* value.

The flow margin top value sets the beginning vertical coordinate where a flowing report starts on each new page.

**Note:** When flow margins are changed from the default value, you can see the flow margins in the Design View of Document Composer. In the following image, the top flow margin appears below the bounding rectangle and above the report object:

![Image of Regional Fund Balances](image)

4. Adjust the objects in the Design View between the flow margins and run the report.
The report fills each page between the flow margins until it reaches the end. For example, in the image below, the flow margin was adjusted so that an image could be used as a header.

Setting a Relative Position Between Objects in Document Composer

You may set a relative (vertical) relationship between objects. Similar to the flowing report option, you can select multiple report and graph objects and set a relationship. The following relationship options are available from the Positioning toolbar in Document Composer:

- **Relate Bottom Left.** Sets the relative relationship or distance between two objects.
- **Break a Relationship.** Removes the relationship between two objects.
- **Show relationships.** Shows or hides all relationships on the page layout.

**Note:** There is currently no method of controlling horizontal overflow. The report always expands beyond the bounding rectangle and is clipped at the end of the page.
**Procedure:** How to Relate Surrounding Objects to a Report

A surrounding object can only be related to one flowing report. However, a flowing report can have multiple surrounding objects related to it.

1. In Document Composer, select an object from the Design View.
2. Select two reports, or a graph and a report, by using the Ctrl key to select the surrounding objects.

3. Set the relationship between the objects by selecting the `Relate Bottom_ Left` button from the Positioning toolbar.

   **Note:** The relationship buttons are only available from the Positioning toolbar when multiple objects are selected.

   An arrow appears in Design View, indicating that the relationship has been set.
In the following image, the graph is the surrounding object to the report:

4. Run the report.

Note: If the document contains multiple reports, and the relationships have been set, the first report runs at run time. Once it is complete, the surrounding reports follow.
Note: If the document contains a report and a graph, and the relationship has been set, the report runs first, at run time. Once it is complete, the graph follows.
Reference: Rules for Setting Relationships Between Objects

The following rules apply when setting relationships between objects:

Setting relationships (relate top left to bottom left)

This sets a relative distance between the flowing report and a surrounding object. The surrounding object is rendered immediately following the end of a flowing report, with the related distance between the end of the flowing report and the beginning of the surrounding object.

Fixed objects

A fixed object cannot be broken across a page break. It needs enough vertical space to fit on the last page of the flowing report.

If the surrounding object is fixed in size, such as a graph or a fixed report, then you must set the Sizing Requirement property to ensure that there is enough space to display the object. If not, the object is automatically rendered at the top flow margin of the next page.

Flowing object (reports)

A flowing report can be broken across pages. The reporting server determines if there is enough room to begin rendering the surrounding flowing report.

You can optionally set the sizing requirement for a report that is relatively positioned to ensure that the report is not broken at the wrong spot. For example, to ensure that the heading appears with information below it.

Note: The sizing requirement is only applicable to a report that is relatively positioned to another flowing report. It does not apply to any other object.

Draw object

Relationships do not apply to draw objects such as images, lines, and text. Draw objects (not repeating objects in the Page Master) can be placed above flowing reports in a page layout, but draw objects placed below a flowing report (not repeating objects in the Page Master) should be placed outside of the bottom flow margin.

Setting a relationship between a report and a graph

If the overflow property of the report is set to flowing, and there is no set relationship between the graph and report, then the report will overlap and display on top of the graph at run time. There is no way for Document Composer to automatically set relationships, so you must set the relationship between the report and the graph.
Note: A surrounding object can only be related to one flowing report. However, a flowing report can have multiple surrounding objects related to it. The surrounding object is that which is related to the primary object.

Adding Different Headers and Footers on an Overflow Page

When using a coordinated compound document, any report component that exceeds the designated vertical coordinates within the page layout automatically generates an overflow page at run time. You may customize the layout of the subsequent pages by adding a new overflow layout page for the selected page layout. This enables you to add different headers and footers between the first page of the report and the overflow pages of the report.

In general, each report appears once for each page layout and continues until the data is complete. The new overflow page option enables you to specify reports or graphs that should repeat on each subsequent page to create different headers or footers.

For example, the outline below details how adding a new overflow page may be useful in creating headers and footers for overflow data.

- Create a page layout with a report component that creates overflow. For example, a report component on a single page layout generates seven pages of output.

- The first page of the report output inherits any styling that is applied on the Page Master, if applicable.

- The second page of the report output is the beginning of the overflow results for the first coordinated sort value.

- In Design View, you may add a new overflow page to the page layout. This enables you to add reports and graphs (as header and footer information) around the overflowing object.

  Tip: A report component added to the overflow page, as a header, may contain data such as variable data inserted through a report.

- The report and graph components added to the overflow page appear as headers and footers for the overflow pages of the report output. In this scenario, page two of the document will display the report component added to the overflow page.
This section describes **How to Add a New Overflow Page to a Page Layout** on page 68, **How to Add Header and Footer Information to the Overflow Page** on page 71, and **Usage Notes for Adding Components to an Overflow Page** on page 73.

**Procedure: How to Add a New Overflow Page to a Page Layout**

Each page layout works independent of any other page layout in the coordinated compound document. This enables you to add a new header and footer for each individual page layout and associated overflow pages. The following procedure describes how to add a new overflow page from the page layout.

You may use any of the following methods to create an overflow page:

- From a fixed report component in a coordinated compound document.
Select the report component in the page layout, right-click, and select *Customize Fixed Overflow* from the context menu.

The overflow page, displaying a copy of the fixed component (with the original size and position) from the page layout, is added after the page layout in Design View. This enables you to move and resize the overflow object, and add reports and graphs (as header and footer information) around the overflowing object.

![Image of page layout with overflow object]

- On a page layout with a fixed or flowing report.

Select *Add New Overflow Page* from the New Page Layout drop-down list.
Click anywhere on the page layout, right-click, and select Add New Overflow Page from the context menu, as shown in the following image:

The overflow page is added after the page layout in the Design View. You may add reports and graphs to the overflow page.
**Note:** If there is a flowing report component, any flow margins defined on the page layout will also appear on the overflow page. This enables you to move and resize the flow margins, and add reports and graphs (as header and footer information) around the flow margins.

The overflow page is identified as Page layout \( n \), overflow object, where \( n \) is the number of the corresponding page layout. The overflow page can also be accessed from the drop-down list of objects in the Properties window.

![Properties Window](image)

**Procedure:** How to Add Header and Footer Information to the Overflow Page

You may add report and graph components on the overflow page as header and footer information for the overflow data, and position and size the components as desired. You may copy existing components from the page layout, or add new report and graph components. All components added to the overflow page are automatically assigned as fixed components on the overflow page.

**Note:** The report and graph components added as headers and footers should not generate additional overflow.

1. To copy an existing report or graph component from the page layout:
   - Select the component from the original page layout, right-click, and select Copy.
Select Page layout n, overflow object from the Properties window drop-down list, or scroll down in the Design View until you see the overflow page.

The overflow page appears in the layout.

Right-click and select Paste.

The component is copied to the overflow page, maintaining the size and position from the page layout.

Note: If the component was flowing on the original page layout, it is then automatically changed to a fixed object on the overflow page.

2. To add a new report or graph component to the overflow page:

Select Page layout n, overflow object from the Properties window drop-down list.

The overflow page appears in the layout.

Right-click and select New Report or New Graph from the context menu.

Note: You may also add these components through the Insert menu, or the Components toolbar, of Document Composer.

The cursor changes into a crosshair.

Click and drag the crosshair to create a report object, or graph object, and adjust it to the size you want.

Open, import, or reference report or graph information as usual. This behavior is identical to adding a report or graph on the page layout.

Note: Keep in mind that these objects are acting as header and footer information, so they should not generate additional overflow.

3. To edit the report or graph component on the overflow page, double-click the object to open the associated tool and apply any styling or data changes.
The following image is an example of an overflow page with a report component added as header information. The report contains a variable added to the page heading of the report with styling applied to the text (within the report) in the page heading.

Reference: Usage Notes for Adding Components to an Overflow Page

The following apply to adding reports and graphs as header and footer information to an overflow page:

- Ensure that report components added to the overflow page do not generate overflow. The Overflow and Styling options are not available on the overflow page and are automatically set to be fixed objects. The space provided for the report component must be sufficient to present all of the data generated within the report, so that subsequent overflow is not generated.

- Additional images, lines, and text can be added to the overflow page by inserting them into report components.

- By default, copying a component from the page layout to the overflow page retains the position attributes, so you can easily ensure the positioning is the same on the page between the first and overflow pages.
Applying a Table of Contents and Bookmarks

You may generate a Table of Contents (TOC) page in Document Composer that shows a summary of the contents of the document, along with page numbers, and that can be printed with the document. The entries can link to any component of the compound output (page, report, or graph) and vertical sort field values (BY field values) within each component report. The entries in the Table of Contents enable you to easily navigate to a particular section while viewing the document online.

When creating a compound layout report or a coordinated compound report in Document Composer, you can enable bookmarks available in Adobe® Acrobat® for PDF formatted reports. Bookmarking uses the Table of Contents descriptions, and the Table of Contents page and levels, to show specific reference points in the compound document.

In this chapter:

- Adding a Table of Contents Page
- Using Bookmarks in Document Composer

Adding a Table of Contents Page

You may generate a Table of Contents (TOC) page in Document Composer that shows a summary of the contents of the document, along with page numbers, and that can be printed with the document. The entries in the Table of Contents enable you to easily navigate to a particular section while viewing the document online.

The actual content of the Table of Contents is represented as a text element in Document Composer. When using a Table of Contents page, you may:

- Customize the size and position of the Table of Contents element.
- Customize the title of the Table of Contents, as well as the format of the text.
- Control which reports and graphs show up in the Table of Contents by customizing the object properties.
- Enable TOC page numbering so that each element in the Table of Contents is numbered. You may also add trailing dots from the entry to the page number for easier selection of the contents.
Use hypertext links in the Table of Contents page, which enable you to click on an entry and jump to the specified page in the document.

The following image is an example of the Table of Contents page shown at run time:

![Table of Contents Example](image.png)

**Note:** If the Table of Contents overflows to more than one page at run time, then the remaining content is executed with the same size and dimensions as the first page until the entire TOC has been output.

**Procedure:** How to Create a Table of Contents Page in Document Composer

1. Select *Add Table of Contents Page* from the Insert menu of Document Composer.

   or

   Select this option from the New Page Layout button ![New Page Layout Button](image.png) from the Positioning toolbar.
The Table of Contents page appears in the Design View.

Table of Contents appears as the default title for the page. To customize the title of the Table of Contents, simply edit the text. Double-click to go into edit mode and type your new text.

**Note:** The text will not wrap and must fit within the width of the overall text element.

2. Optionally, you may edit the TOC numbering and tab leading options for the Table of Contents by using the Properties window.

3. Click *Run* to load your document.

   The Table of Contents appears as the first page in your output.
4. Click a hypertext link on the Table of Contents page to jump to that section within the document.

**Procedure:** How to Control Which Objects Appear in the Table of Contents

**Note:** The objects that appear in the Table of Contents depend on whether the document is coordinated or uncoordinated. For details, see *Controlling Which Objects Appear in the Table of Contents* on page 80.
The following is an example of how to control which objects appear in the Table of Contents:

1. Select a report, graph, or page layout object by selecting the object in Design View, or by using the Properties drop-down list to select the object.

   Each report, graph, and page layout object has a TOC description, TOC level option, and TOC Number of sort levels in the Properties window.

   **Note:** By default, all report, graph, and page layout objects are shown in the Table of Contents for uncoordinated documents. For details about which objects appear in the Table of Contents, see *Controlling Which Objects Appear in the Table of Contents* on page 80.

2. To change the name of the description for the object, type over the TOC description in the Properties window.

   This description appears in the Table of Contents at run time.

3. To change the hierarchical order of how the object appears in the Table of Contents, type in a TOC level.

   For example:

   - 0 = the object is not shown in the Table of Contents.
   - 1 = the object is shown as a first level item in the Table of Contents.
   - 2 = the object is shown as a second level item in the Table of Contents.

   Follow this sequence for additional levels.

   These levels appear in the Table of Contents at run time.

4. To change the number of vertical sort fields (TOC levels) that appear in the Table of Contents for the component, use the up or down arrow to adjust TOC Number of sort levels in the Properties window. If the value designated is greater than the count of BY fields in the component report, then the value defaults to the total count of available BY fields.

   **Note:** Coordinated reports do not support TOC Number of sort levels within a compound TOC. Those entries are ignored for coordinated reports.

5. Run the procedure to see the updated TOC description and TOC levels.
The following image is an example of a Table of Contents with two levels: *Regional Balance Analysis* as a TOC level 1 Page Layout, *Regional Fund Balance Report* as a TOC level 2 report, and *Regional Balance Chart* as a TOC level 2 graph.

![Table of Contents Image](image)

**Reference:** **Controlling Which Objects Appear in the Table of Contents**

The objects that appear in the Table of Contents depend on whether the document is coordinated or uncoordinated.

**Note:** The Coordinate report option is available from the Compound document Properties window in Document Composer. See *How to Create a Coordinated Compound Layout* on page 31 for more information about creating coordinated documents.

For an uncoordinated document, the TOC presents all of the page layouts and components designated in the TOC parameters. For example, a TOC might contain a list of all objects on the page:
For a coordinated document, the TOC presents a reference to each of the coordinated sort fields, with a link to the first page of the associated pages for that common sort field. For example, the TOC might contain a list of countries:

England
France
Italy

**Note:** If using a coordinated document with ReportCaster, the coordinated document is burst to create individual reports for each instance of the common sort field. These individual reports are then handled as uncoordinated reports and a TOC is generated to represent the page layouts and components within the sort field, resulting in a list of all objects on the page.

**Reference:** Properties for the Table of Contents Text Element

The following image is an example of the Table of Contents element and its properties:

![Table of Contents properties](image)

**Note:** You can edit the size and position of the Table of Contents text element by clicking and dragging the text element on the page.
Adding a Table of Contents Page

The properties for the Table of Contents text element consist of:

**Name**

The descriptive text that represents how the content within the Table of Contents appears at run time. You may edit the font and style of this text.

**Position: Left**

The left margin position of the Table of Contents text element on the page.

**Position: Top**

The top margin position of the Table of Contents text element on the page.

**Size: Height**

The dimension height of the Table of Contents text element on the page.

**Size: Width**

The dimension width of the Table of Contents text element on the page.

**Styling: Font**

Opens the Font dialog box enabling you to edit the Font, Font Style, Color, and Font size for the contents within the Table of Contents.

**Styling: Z-Index**

Defines the Z-Index property of an object.

**TOC numbering**

Adds section numbers to the left of the TOC description for each entry within the Table of Contents.

*Note:* TOC numbering is ON by default.

**TOC tab leader**

Adds leading dots to the content within the Table of Contents.

*Note:* DOTS is OFF by default.
Using Bookmarks in Document Composer

When creating a compound layout report or a coordinated compound report in Document Composer, you can enable bookmarks available in Adobe Acrobat for PDF formatted reports. Bookmarking uses the Table of Contents descriptions, and the Table of Contents page and levels, to show specific reference points in the compound document.

Note: Bookmarks are only applicable for documents in PDF output format.

Procedure: How to Use Bookmarks in Document Composer

1. In Document Composer, create a compound layout that is comprised of multiple reports and/or graphs.
2. Use the Properties window to select each report or graph and enter a bookmark (Table of Contents) description, or use the default selections.

Note: The Table of Contents page may or may not be included in the compound document. However, the descriptions and levels that appear as bookmarks are set through these options.

4. From the Bookmarking drop-down list, select On.

Note: Bookmarking is off by default.

5. Click Run to load your document.

The bookmark tab is expanded in the PDF output.
6. Click a bookmark link to jump to that section within the document.
With report components created in Report Painter that have DRILLTHROUGH specified in their StyleSheets, you can use Drill Through to define hyperlinks between the individual report components embedded within a single PDF formatted document.

In this chapter:

- **Using Drill Through**

Using Drill Through

Drill Through provides a way to easily relate data in separate reports within a PDF-formatted document. In Document Composer, you can internally link reports using the Drill Through Destination property.

**Note:** Reports that you wish to set Drill Through Destinations for must be created with Report Painter. Hand coded reports will not work correctly.

**Procedure:** **How to Set the Drill Through Destination**

The following is an example of how to set the Drill Through destination for a report component in the Document Composer:

1. Create a PDF compound document in Document Composer and place all of the report components on the canvas. Select a report that has DRILLTHROUGH syntax specified.

2. Select the *Drill Through Destination* drop-down list. The list displays all of the other report component names on the document.

   **Note:** If the report that is selected does not have DRILLTHROUGH syntax specified then the Drill Through Destination drop-down list will be deactivated.

**Reference: Usage Notes for Drill Through**

- The document must be in PDF format.
- Drill Through Destinations should only be set once all components are added to the document.
- When creating a report in Report Painter, only one Drill Through behavior can be specified per report.
- The field specified to contain a Drill Through behavior must also be present in the target report.
- Drill Through is only supported for reports, not charts.
A Page Layout is an individual document, or page, that maintains images, drawing objects, text, page settings, reports, and graphs. You can save this pre-styled page and reuse it like a template, or make it available to others.

**In this chapter:**
- Using Page Layouts

### Using Page Layouts

A Page Layout is an individual document, or page, that maintains images, drawing objects, text, page settings, reports, and graphs. You can save this pre-styled page and reuse it like a template, or make it available to others.

**Procedure:**  **How to Save an Individual Page Layout in Document Composer**

1. Select **Save Current Page As** from the File menu to save the individual page, or select this option from the Save button on the Standard toolbar.

2. Type in a file name for the individual page.

   **Note:** If you select an existing procedure name (.fex), the Specify Name dialog box appears, asking if you want to replace the file.

3. Click OK to close the Save Current Page As dialog.

The individual page is saved as a new procedure maintaining images, drawing objects, text, page settings, reports, and graphs.

**Note:** These files can be saved to your local desktop or anywhere in the WebFOCUS environment. However, when saving to a local project, the file is not automatically added to the project.
Procedure: How to Add an Existing Page Layout in Document Composer

To add a previously saved page layout:

1. Select Add Existing Page Layout from the Insert menu of Document Composer or
   Select this option from the New Page Layout button on the Positioning toolbar.

2. Select the procedure file (.fex) of the page layout.

3. Click Open.

   The selected procedure is added to the open procedure.

   a. There may be an additional step if a Page Master exists in the current layout.

      A message appears stating that a Page Master already exists in the current layout. You may replace the Page Master, merge the two, or ignore the Page Master.

      <image>

   b. Click Yes to replace the existing Page Master with the new one.

      Click No to merge the two Page Masters and combine all of the objects from both Page Masters.

      Click Cancel to use the existing Page Master and ignore the Page Master from the page layout.

      The new page layouts are appended to the end of the document.

      For more information about Page Masters, see Using Page Masters in Document Composer on page 47.

Procedure: How to Insert an Existing Page Layout Before or After the Current Page Layout

1. Open or create a document.
2. Right-click on a page layout.

   The context menu opens, as shown in the following image.

3. Select either Insert existing page after or Insert existing page before.

   The Get source file dialog box opens.

4. Navigate to a previously saved page layout, select it, and click Open.

   The previously created page layout is inserted either before or after the page layout you selected.

**Procedure:** How to Insert a New Page Layout Before or After the Current Page Layout

1. Open or create a document.
2. Right-click on a page layout.
Using Page Layouts

The context menu opens, as shown in the following image.

![Context menu image]

3. Select either Insert new page after or Insert new page before.
   
The new page layout is inserted either before or after the page layout you selected.

Procedure: How to Set Different Page Orientations for Individual Page Layouts

You may set portrait and landscape page orientations for different pages in one document. Page orientations set at the Page Layout level override the page orientation set at the Compound Document level. If no page orientation is set for the individual page layout, then the Compound Document page orientation property is applied to all pages in the document.

Note: Page orientation settings are ignored if you are using PowerPoint as the document output format.

1. Select a page layout from the drop-down list of objects in the Properties window.
   
The corresponding page layout properties appear.
2. Use the Page Orientation drop-down list to select Landscape or Portrait.

![Properties](image)

**Note:** <Not Set> is the default selection. If no page orientation is set for the individual page layout, then the Compound Document page orientation property is applied to all pages in the document.

3. Save and run the report.

   The page orientation is shown as either Landscape or Portrait for the selected page.
For example, the following image shows a report where the last page layout (Graph) is set to Landscape:
You may format individual text elements or style entire strings of text in Document Composer.

In this chapter:

- Formatting Text Elements

Formatting Text Elements

You may format individual text elements or style entire strings of text in Document Composer. The formatting options are available from the Formatting toolbar.

You may format individual pieces of text by using the Bold, Italic, Underline, Superscript, and Font Style options. If the entire text element is selected, Font Style and Alignment options are available.

**Note:** These text formatting options are only available in Document Composer when PDF is set as the Compound document output format.

Procedure: How to Apply Various Formatting in a Text Element

You may apply various formatting and style options to words and individual text characters within the text element.

1. From Document Composer, add a text element to the page.
   
   Select Text from the Insert menu.
   
   or

   Select the text button from the Components toolbar.

   The cursor changes into a crosshair.

2. Click and drag the crosshair to create the text element on the page and adjust it to the size you want. Double-click, or highlight and single-click the text element, to go into edit mode.

3. Type text in the text element.

**Note:** Line breaks can be set by using the Enter key when typing text in a text element.
4. To format the text, highlight part of the text within the text element.

The Formatting toolbar is activated.

5. Select Bold, Italic, Underline, Superscript, or Font Style from the Formatting toolbar.

   **Note:** You can also access the formatting options from the context menu, as shown in the following image.

6. The Font Style option opens the Font dialog box where you can change the type, style, color, size, and effect of the font.

   **Tip:** You may also access the Font Style dialog box from the Font ellipsis button of the Styling Font field in the Properties window.

7. Click OK to close the Font dialog box.

   The font options are applied to the text selected.
Procedure: How to Insert a Bulleted List or Numbered List Into a Text Element

To insert a bulleted list or numbered list into a text element:

1. Insert a text element into the layout and type text on different lines, as shown in the following image.

2. Highlight and right-click the text.
   
The context menu opens.

3. Select Bullets and then either Disc, Circle, or Square if you want a bulleted list. Select Numbering and then either Numbers, Lowercase Letters, Uppercase Letters, Small Roman numerals, or Large Roman numerals if you want a numbered list. Both options are shown in the following image.
For example, the following image shows each item of text on a different line with a bullet next to it.

- Eggs
- Milk
- Bread
- Butter

**Note:**

- Alternatively, you can select a bullet type before typing text to begin the list. Press the Enter key to begin the next item in the list on a separate line.

- To change the bullet or number list type of an existing list, place your cursor on the list level you want to change and reselect a bullet or number list type. Selecting *None* will remove the bullets or numbers for that level and move any nested lists up one level. In order to switch between bullets and numbers, you must first remove the current list option by selecting *None* and then applying the list option you want.

**Procedure:** How to Insert Nested Lists Into a Text Element

To insert a nested list into a text element:

1. Insert a text element into the layout and create a list, as shown in the following image.

1. Eggs
2. Milk
3. Bread
4. Butter
2. Place your cursor after a list item.
3. Right-click and select Nested List and then select a bulleted or numbered list option.

A list is started within the current list, allowing you to enter text on that list level, as shown in the following image.

![Image of nested list]

**Note:** Pressing the Tab key while your cursor is on the same line as a list item will move that item one level down, resulting in a nested list. The bullet or number type selected is the next list type in the context menu. For example, if you have a bulleted list that uses the disc bullet type, pressing tab to move an item down one level will cause that nested list to have the circle bullet type.

You can continue to nest lists within other lists by using the same steps shown above.

**Note:** You cannot skip a list level. For example, in order to insert a nested bulleted list or nested numbered list on a lower level, there must be a list one level up from it.

**Procedure: How to Apply Formatting to an Entire Text Element**

You may apply formatting and style options to the entire text element in Document Composer.

**Note:** Any formatting and styling that you may have applied to individual text strings within the text element will remain unchanged. Changes made to the entire text element are only applied to the part of the text string that has not been formatted.

1. Insert a text element into the layout and type text in the text element.
2. Single-click the text box in the layout, as show in the image below.

![Sales Report](image)

or

Select the text element from the Properties window drop-down list, which appears as text(n).

3. Select the Font ellipsis button from the Styling Font field in the Properties window.

The Font dialog box opens.

4. Select the type, style, color, size, and effect of the text element.

**Note:** The default font is Trebuchet MS 10pt.

5. Click OK to close the Font dialog box.

The font options are applied to the text element.

**Procedure:** How to Align Text Within the Text Element

You may apply alignment options to the text within the text element.

1. Insert a text element into the layout and type text in the text element.
2. Single-click the text box in the layout.
   or
   Select the text element from the Properties window drop-down list, which appears as text(n). The Alignment options on the Formatting toolbar are activated.

3. Select Align Left, Align Center, Align Right, or Full Justification.

   **Note:** The default is set to Align Left.

   The alignment format is applied to the text element.
Adding Page Numbers to Your Document

You can add page numbering objects in Document Composer by using text elements in the Page Master. Page numbers are applied to the entire document.

In this chapter:
- Adding Page Numbers to Your Document

Adding Page Numbers to Your Document

You can add page numbering objects in Document Composer by using text elements in the Page Master. Page numbers are applied to the entire document.

You may position these page numbering objects anywhere on the Page Master and style them just like any other text element in Document Composer.

Note: Page Numbering can only be added to the Page Master.

Procedure: How to Add Page Numbering Objects in Document Composer

1. Create a Page Master in the Document Composer:
   - From Document Composer, select Add Page Master Layout from the Insert menu.
   - or
   - Select this option from the New Page Layout button from the Positioning toolbar.
   - The Page Master appears in the Design View.
   - Add elements and set properties for the elements in the Design View.

   Note: Only text, images, and lines can be added to the Page Master.

2. Add a page numbering object to the Page Master.
   - Select Text from the Insert menu.
   - or
Select the text button on the Components toolbar.

The cursor changes into a crosshair.

Click and drag the crosshair on the Page Master to create the page numbering object, and adjust it to the size you want.

**Note:** Page numbering objects can have accompanying text and they can be positioned anywhere in the Page Master.

3. Double-click, or highlight and single-click, the page numbering object to go into edit mode.

4. Right-click the page numbering object, select Insert, and select a page numbering option from the context menu.

The page numbering object is added to the Page Master.

**Reference:** Page Numbering Options

The following image shows the page numbering options available from a page numbering object in the Page Master.

The following page numbering options are available from the Insert context menu:

**Page Number**

Adds the `<Page #>` object, representing the current page number of the document.

**Total # of pages**

Adds the `<Total pages>` object, representing the total number of pages in the document.
Pages n of n

Adds the <Page # of ##> object, representing the current page number of the total number of pages in the document.

Date and Time

Adds the date or time in any of the selected formats:

- mm/dd/yy
- mm/dd/yyyy
- Month (First three letters) Day, Year
- Month (Full Name) Day, Year
- Day Month, Year
- Quarter Year
- HH.MM.SS

**Note:** THE HH.MM.SS format is a time format. The time is updated dynamically to display the current time at run time.

**Procedure:** How to Reset Page Numbers in a Coordinated Compound Report

Within a coordinated compound report, you may select whether page numbers are reset at each new coordinated sort key value or run continuously through the entire document. The Reset Page Number option enables the coordinated compound layout to be used to create single continuous reports across sort values, or to burst into individual reports by the primary sort key, and retain the desired page numbers.

**Note:** The Reset Page Number option is only available when the Coordinate report property is set to On.

1. Ensure that a page numbering object exists in the Page Master.
2. From the Properties window in Document Composer, select Compound document from the Properties list.
3. Select On from the Coordinate report properties field.
The Reset Page Number option appears in the Properties window.

<table>
<thead>
<tr>
<th>Property</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmarks</td>
<td>Off</td>
</tr>
<tr>
<td>Coordinate report</td>
<td>On</td>
</tr>
<tr>
<td>Output format</td>
<td>PDF</td>
</tr>
<tr>
<td>Page margin: Bottom</td>
<td>0.5</td>
</tr>
<tr>
<td>Page margin: Left</td>
<td>0.5</td>
</tr>
<tr>
<td>Page margin: Right</td>
<td>0.5</td>
</tr>
<tr>
<td>Page margin: Top</td>
<td>0.5</td>
</tr>
<tr>
<td>Page orientation</td>
<td>Portrait</td>
</tr>
<tr>
<td>Page size</td>
<td>Letter</td>
</tr>
<tr>
<td>Reset Page Number</td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td>Inches</td>
</tr>
</tbody>
</table>
4. Select On or Off from the Reset Page Number properties field.

Reset Page Number affects both the individual page number and the total pages within each document.

- On resets page numbers to 1 at each new value of the primary coordinated sort key.
  
  With On selected, total pages is set to the page count for the current value of the coordinated sort key.

- Off enables page numbers to run continuously through the document.
  
  With Off selected, total pages is set to the actual total page count within the overall document.

**Note:** Page numbering in the Table of Contents is not affected by the Reset Page Numbers selections, and displays the actual page numbers within the overall document. For more information about the Table of Contents, see *Adding a Table of Contents Page* on page 75.

5. Save and run the document.

The output generates separate page layouts by the common sort field.

In the example below, Reset Page Numbers is set to On, showing Pages 1 of 5 as the page number and total page number for the first sort field, where the Region is Central America.
When the primary sort value (Region) changes to Eastern Europe, the page number resets to 1 (Page 1 of 4).

In the same example below, Reset Page Numbers is set to Off, as indicated by the page numbers (Page 1 of 37) that run continuously across all sort values through the document.


Reference: Restrictions for Importing Images in Document Composer

When selecting images from Document Composer, images must be stored in a location on the application path of the WebFOCUS Reporting Server. Images stored in any other location outside of the WebFOCUS Reporting Server application path will produce errors at run time.

Note: If you specify an application path at the Managed Reporting report or Domain level, using the Managed Reporting Properties option, Document Composer copies image files to the application directory. If no application path is specified in the Managed Reporting Properties for the report or domain, copy the image file to an application directory that is on the application path of the WebFOCUS Reporting Server.
Creating Active Technologies Dashboards in Document Composer

An active report is a self-contained report that is designed for offline analysis, meaning it contains all of the data and JavaScript within the output file. Document Composer can be used to develop active dashboards which combine multiple active reports into a variety of scenarios that are coordinated with a common sort field and controls to filter the data in active reports.

In this chapter:

- Using Active Technologies Reports to Create Active Dashboards
- Positioning Report Objects in the Active Technologies Dashboard
- Working With Active Technologies Form Controls

Using Active Technologies Reports to Create Active Dashboards

An active report is a self-contained report that is designed for offline analysis, meaning it contains all of the data and JavaScript within the output file. Document Composer can be used to develop active dashboards which combine multiple active reports into a variety of scenarios that are coordinated with a common sort field.

An active report for Adobe® Flash® Player includes most of the capabilities available in the HTML version of an active report in a visually enhanced, user-friendly report format. An active report delivered as a self-contained Adobe Flash Player compatible file (SWF) allows for faster analysis of large data sets and interaction with the active report. Internet Explorer, Mozilla Firefox, and Opera Internet browsers recognize an active report for Adobe Flash Player as a Shockwave Flash Object.

Tip: Any discussion of active reports includes active reports for Adobe Flash Player and for PDF, unless otherwise noted.

- Select the active report or active Flash output format from the output format drop-down list in the Properties window of Document Composer.
You may also use Active Technologies for PDF, which provides the ability to include interactive reports, dashboards, and animations compatible with Adobe Flash Player in PDF documents. Select the active PDF output format from the output format drop-down list in the Properties window.

An active dashboard is an extension of an active report. Therefore, all active report features are available for an active dashboard.

For more information about individual active report features, see the Active Technologies User's Guide.

An active dashboard is best suited for developing storyboards with multiple charts and tables that give you a complete view of a business issue. You can send active dashboards as stand-alone dashboard pages or incorporate them into corporate dashboards.

A typical active dashboard displays several different scenarios, each on its own page, that are accessible by selecting the appropriate panel at the top of the page. The following image shows an example of an active dashboard with three scenarios, Revenue Report (selected), Regional Report, and Product Report.
The following image shows an active dashboard for Adobe Flash Player. The active dashboard displays several different scenarios, each on its own page, that are accessible by selecting the appropriate panel at the top of the page. The image shows an example of an active dashboard with three scenarios, Revenue Report (selected), Regional Report, and Product Report.

When you create an active dashboard in Document Composer with the active PDF output format (APDF), bookmarks are not supported.
Positioning Report Objects in the Active Technologies Dashboard

When all active reports have been imported or referenced in Document Composer, you must position the active report objects into their respective pages (page layouts). Each page corresponds to a different scenario represented by multiple active report objects.

The end result is the visual, analytical active dashboard that universally binds multiple active reports into separate scenarios that can be paged through to view the content. Because all of the reports are a type of active report, each report retains its own menu functionality, pivoting, or charting capabilities. This enables each active report to be modified and saved individually, or as an entire active dashboard, which creates a small, portable file.

Procedure: How to Position Report Objects in the Active Technologies Dashboard

Each page layout in the coordinated compound document creates a separate page in the active dashboard. These pages are accessible through the active dashboard panels at run time. You must build each page layout in Document Composer.

1. In Document Composer, name the panels for the active dashboard by changing the name of the TOC description in the Page Layout.
   - Click anywhere in the Page Layout, or select Page layout(n), where n is the number, from the Properties window drop-down list.
   - In the Properties window, double-click the TOC description properties field.
   - Enter a name for the active dashboard.

   Each panel name in the active dashboard corresponds to the TOC description properties field.

2. On the Insert menu, select Add New Page Layout to add additional page layouts and repeat the steps from How to Create an Active Technologies Dashboard in Document Composer on page 117.

3. Optionally, you can insert images and text in the page layout that will appear in the active dashboard.

4. Save and run the active dashboard.
**Example:** An Active Technologies Dashboard

The following image is an example of an active dashboard.

Every type of active report visualization is demonstrated in the image above. These types include pie, line, and bar charts, a tabular report, and a pivot table. You can quickly switch from one reporting scenario to another by clicking on each of the panels at the top of the page.

Each panel on the active dashboard corresponds to a page layout from the coordinated compound document, and displays as the name in the TOC description properties field.

The active dashboard is universally filtered by the region field, represented by the Region dropdown list, which is also located at the top of the page in the preceding image.
The drop-down list for the primary sort field lists all the values found for the primary sort field among the active reports, and will filter the entire active dashboard.

The tabs and drop-down list in an active dashboard are shown in the following image.

![Century Electronics Region Revenue Report](image)

Each type of active report in an active dashboard provides you with powerful reporting menus that you can use to further refine the content. An example is the active report column heading menu that is shown in the following image.

![Century Electronics Detailed Revenue Report](image)
Working With Active Technologies Form Controls

The use of active dashboards adds to the existing capabilities of active reports and integrates them using Document Composer Coordinated Compound Report functionality.

The following are characteristics of active dashboards:

- All active reports in an active dashboard must have the same first (primary) sort field, which can originate from multiple Master Files, but must be the same name and format.

- The common primary sort (BY) field is used to merge all of the active reports for cross-scenario and cross-report filtering. When an active dashboard is executed, WebFOCUS uses the common primary sort field to automatically build the drop-down list that is used to select sort field values at the top of the page.

- Multiple active reports are embedded into a compound document to create an active dashboard.

- In the compound document Properties window of Document Composer, set the Coordinate report property of the object to On and the Output format to active report, active Flash, or active PDF.

- Each page layout of a compound document represents a different business scenario and appears as a separate tab at the top of the active dashboard.

- All active dashboard characteristics are available when using the active Flash output format.

You also have the ability to set an active report initial presentation style, which enables active reports to render as reports, pivot tables, or charts. With these types of visualizations packaged into the active report output, active reports can be integrated with Coordinated Compound Reports to present reports, pivot tables, and charts all within the same page.

**Tip:** When you create active dashboards using Document Composer, active reports (regardless of the initial presentation style setting) are to be imported, referenced, or created using the Report object, not the Graph object.

Adding active form controls to an active dashboard locks you into the active dashboard mode. For more information, see *Active Technologies Dashboard Mode* on page 126.
**Procedure:** How to Create an Active Technologies Report With Active Technologies Dashboard Characteristics

Ensure that your active reports comply with the characteristics of active dashboards. You can modify an existing active report or create new ones that meet the criteria.

1. Open or create a new report in Report Painter.
2. Select an active report format from the Output Format drop-down list.
3. Select By from the Columns toolbar and add the primary sort field to the active report.
   
   The first field must be a visible By field for active dashboards. All values found as the primary sort field will be listed in the active dashboard.

4. Ensure that the first field has the same name as the column name.
   
   The first field must be the same name and format for active dashboards.
   
   - Right-click on the By field and select Column Title from the context menu.
     
     The Title dialog box appears.
   
   - Type the column field name that will be used as the primary sort field among the active dashboards, if applicable.
   
   - Click OK to close the Title dialog box.

5. Select Format from the Report menu.
   
   The Format tab of the Report Options dialog box opens.

6. Click the Initial Presentation drop-down list to select a presentation style for the active report.

   When the active report is integrated in the active dashboard, it can present reports, pivot tables, and charts all within the same page.

   **Tip:** When you create active dashboards using Document Composer, active reports (regardless of the initial presentation style setting) are to be imported, referenced, or created using the Report object, not the Graph object.

7. Save and close the active report.
In the following example, there are three HTML Reports that show REGION as the first visible By field in the report. These active reports comply with the active dashboard characteristics.

**Procedure: How to Create an Active Technologies Dashboard in Document Composer**

1. Create a new procedure with Document Composer:
   - With the Procedures folder highlighted, select *New/Procedure* from the File menu. The Add Procedure dialog box opens.
   - Enter a name for the new procedure in the File name field.
   - Select *Composer* from the Create with drop-down list.
   - Click *Open*.
     - Document Composer opens.

2. Select the following properties from the Properties window:
   - Select active report, active Flash, or active PDF from the Output format properties field.
   - Select *On* from the Coordinate report properties field.
A coordinated compound layout coordinates all reports and graphs from the document with a common sort field. The coordinated report is burst into separate page layouts at run time. Each value for the first sort field displays on a separate page.

The following image shows the Properties window with these options selected.

3. Add multiple active reports to create the active dashboard:
   a. Select *New Report* from the Insert menu.
      The cursor changes into a crosshair.
   b. Click and drag the crosshair to create a report object and adjust it to the size you want.
   c. Import or reference an existing active report.
      □ Right-click on the report object and select *Import existing report* from the context menu.
      or
      □ Right-click on the report object and select *Reference existing procedure* from the context menu.
      The Get source file dialog box opens.
   d. Select the active report and click *Open* to add it to Document Composer.
Repeat these steps to embed multiple active reports into the coordinated compound document that will create the active dashboard.

4. Position the reports in the document. For more information about positioning reports, see Positioning Report Objects in the Active Technologies Dashboard on page 112.

5. Optionally, you can bind objects to an active report. For more information about binding reports, see Binding Objects to an Active Technologies Report on page 119.

6. Add an active form control to the document. For more information about active form controls, see How to Add an Active Technologies Form Control to the Layout on page 121.

Note: Adding an active form control to a document with synchronized active reports results in Document Composer being switched into a limited active dashboard mode. For more information on the active dashboard mode, see Active Technologies Dashboard Mode on page 126.

**Binding Objects to an Active Technologies Report**

You can create multiple views of an active report by binding an active report object to another active report. Binding or synchronizing is the act of configuring an association between an active report and other active report objects in Document Composer.

You can synchronize active report objects and show the synchronized report groups in Document Composer. The synchronize options are available from the Positioning toolbar in Document Composer.

You can only synchronize objects to one active report at a time. If you try to synchronize an object to a second active report, the first synchronization is removed.

**Procedure: How to Synchronize Active Technologies Report Objects to Active Technologies Reports**

When there are objects synchronized to an active report, those objects are updated any time the active report updates.

1. With at least two active report objects on the canvas, select active report, active Flash, or active PDF from the Output format drop-down list of the Compound document Properties window.
2. Select the objects to be synchronized.
   - Select the active report object as the object to be synchronized.
   - While pressing and holding the Ctrl key, select the active report as the report that you want to bind to.

   The synchronize buttons on the Positioning toolbar are activated.
   The binding object (active report) is indicated by clear boxes around the edges. The synchronized object (active report object) is indicated by solid black boxes around the edges.

3. Click the *Relate Bottom_Left* button on the Positioning toolbar.

   ![Relate Bottom_Left button](image)

   The active report object is synchronized and refreshed with data from the active report.
   There is no separate procedure associated with these active report objects. If you right-click these items, there are no options to edit the procedure.

**Procedure: How to Show Active Technologies Report Relationships**

Select *Show relationships* from the Positioning toolbar.

![Show relationships button](image)

An arrow displaying the relationship is shown in the layout.

**Configuring Active Technologies Form Controls in Document Composer**

To add an active form control, it is required that you insert a new control to the layout. Inserting a control type while the output is set to active reports creates an association between the control and an active report, thereby linking actions to directly affect bound active reports.

An active form control is only applicable if there are active reports embedded or referenced in Document Composer.
Procedure: **How to Add an Active Technologies Form Control to the Layout**

Any input control from the Components toolbar can be configured as an active form control.

To add an input control:

1. Select the control type (Text Box, Drop Down List, List Box, Radio Button, or Check Box) from the Insert menu or toolbar.

   **Note:** There must be at least one active report on the canvas for the input controls to be available.

2. Click and drag the crosshair to create a control object and adjust it to the size you want.

   The input control is added as an active form control. You can now configure the control by right-clicking the control and selecting *Properties and settings*.

Procedure: **How to Insert a Dashboard Bar Into the Layout**

A Dashboard Bar is an additional page layout where you can insert controls, reports, and charts that display above the dashboard tabs. The Dashboard Bar is only available for the active report formatted documents. A Dashboard Bar can be a maximum of one page.

You can insert a Dashboard Bar into active Flash and active PDF formatted documents. However, if you run these documents, an empty page will be returned.

To insert a Dashboard Bar:

1. From the Compound document Property list, select either *active report*, *active PDF*, or *active Flash*.

2. From the Insert menu, click *Add Dashboard Bar*.

   The Dashboard Bar is inserted into the document.

   You can now insert controls, reports, and charts that display above the dashboard tabs.

   **Note:** Though the Dashboard Bar can be a full page, it is not recommended that you insert large reports and charts, as this would make the Dashboard Bar appear the same size or larger than the dashboard.
Reference:  **Properties and Settings Dialog Box (Active Technologies Reports)**

The Properties and settings dialog box appears when you right-click an input control.

The Properties and settings dialog box is shown in the image below.

![Properties and Settings Dialog Box](image)

The Properties and settings dialog box contains the following settings:

**Source report**

The selected report will be the report that the target reports are filtered on. The values in Columns will be populated by the columns of the source report. Only one source report can be selected.

**Columns**

Lists all columns from the source report. The target reports will be filtered on the selected column value. Only one column can be selected.

**Condition**

This option sets the condition for how to populate the target reports.

- Equal (default)
- Not Equal
Greater Than
Greater Than or Equal
Less Than
Less Than or Equal

Add "ALL" option
Adds the option to select ALL data source values for the control.

Apply filter on load
When selected, this option causes the default value to be applied to the reports and charts when the page is loaded. This option is not active while Add “ALL” option is selected.

Multiselect
When selected, you can select multiple values from a list box or check box.

Target reports
The selected report or reports that the source report will filter. You can select multiple reports by holding down the Ctrl key.

Procedure: How to Chain Active Technologies Form Controls
You may chain controls to one another by using the Add to current chain button on the Positioning toolbar. Chaining populates controls based on the selected value from the prior control in the chain.

1. With at least two controls on the canvas, select the controls you want to chain.
   - Select the control you want to be first in the chain.
   - While pressing and holding the Ctrl key, select the controls you want to be in the chain from first to last.
   The chaining buttons on the Positioning toolbar are activated.

2. Click the Add to current chain button on the Positioning toolbar.
The selected controls are now chained. The controls will populate based on the selections from each prior control in the chain. To see the chaining relationship between controls, use the `Show Chain order` button on the Positioning toolbar.

**Procedure: How to Remove Active Technologies Form Controls From a Chain**

You can remove controls from a chain by using the `Remove from current chain` button on the Positioning toolbar. To see the chaining relationship between controls, use the `Show Chain order` button on the Positioning toolbar.

1. With a set of chained controls on the canvas, select the first control you want to remove from the chain. While pressing and holding the Ctrl key, select any additional controls you want to remove from the chain. The chaining buttons on the Positioning toolbar are activated.

2. Click the `Remove from current chain` button on the Positioning toolbar.

The selected controls are now unchained.
Switching the Chart Engine

You can switch between the default JavaScript charts and Fusion™ charts. To do this, select compound document from the Properties tab and then select active report from the Output format property list. The Chart Engine property is now available. Select one of the options from the Chart Engine property drop-down list, as shown in the following image.

The Chart Engine options are described below:

- **Standard.** This option changes the engine to use JavaScript charts.
- **Flash.** This option changes the engine to use Fusion charts.
- **Flex.** This option changes the engine to use Flex charts.
- **HTML5.** This is the default chart option. This option changes the engine to use High charts.
Reference: Active Technologies Dashboard Mode

Selecting an active report output type (active report, active Flash, active PDF) from the Output format drop-down list of the Compound document Properties window and inserting an active report activates the input controls in the Insert menu and on the toolbar. Adding an active form control switches Document Composer into a limited active dashboard mode.

In the active dashboard mode, the Output format drop-down list will be populated by only active report, active Flash, and active PDF, as shown in the following image:

To access the other output types, you must remove any active form controls from the canvas. If there are any active form controls on the canvas, the only available output types will be for active reports.
### Glossary

<table>
<thead>
<tr>
<th><strong>active report</strong></th>
<th>An active report is a self-contained report that is designated for offline analysis. It contains all of the data and JavaScript within the output file.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active Technologies Dashboard</strong></td>
<td>Document Composer can be used to develop active dashboards. An active dashboard combines multiple active reports into various scenarios that are coordinated with a common sort field and controls to filter the data.</td>
</tr>
<tr>
<td><strong>bookmark</strong></td>
<td>Uses the Table of Contents descriptions, and the Table of Contents page and levels, to show specific reference points in the compound document.</td>
</tr>
<tr>
<td><strong>component</strong></td>
<td>An object that you can insert into the page layout, for example, a report, graph, or image.</td>
</tr>
<tr>
<td><strong>control</strong></td>
<td>Supplies a list of possible values, except in the instance of a text box, where the user supplies the value. A control enables you to prompt users for a parameter value.</td>
</tr>
<tr>
<td><strong>graph</strong></td>
<td>A graphical representation of data within a Master File. You can use the Graph tool to create graphs, and these graphs can be inserted in the page layout.</td>
</tr>
<tr>
<td><strong>Graph tool</strong></td>
<td>A Developer Studio application in which you can create and style complex graphs.</td>
</tr>
<tr>
<td><strong>live data</strong></td>
<td>Sections of data, taken from the actual files, that are used in your graph and chart previews. This option sends a request to the Reporting Server, and to the database, to get a snapshot of the actual data in the report or graph. You may select the number of records that appear in the report when previewing live data. You may also set the read limit or record limit to control the number of records accessed in the database.</td>
</tr>
<tr>
<td><strong>on demand viewing</strong></td>
<td>The process by which Document Composer only loads the page you are viewing, thereby saving memory when viewing large documents.</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>output format</strong></td>
<td>The format of the output document. The available formats are PDF, HTML, active report, Power Point, Excel, Excel 2007, active PDF, and active Flash format. You can also set the output format to User, which allows the user to define an output format at run time.</td>
</tr>
<tr>
<td><strong>overflow</strong></td>
<td>The area of a report that exceeds its defined space in the page layout. For example, a multipage report and a graph can both be added to a single page layout with the graph positioned beneath the report. The report can flow or fill the page and the graph can be positioned relative to the report so that it appears at the end of the document following the complete rendering of the report.</td>
</tr>
<tr>
<td><strong>page layout</strong></td>
<td>An individual document, or page, that displays images, drawing objects, text, page settings, reports, and graphs. You can save this pre-styled page and reuse it as a template, or make it available to others.</td>
</tr>
<tr>
<td><strong>Page Master</strong></td>
<td>A page in the Design View where you can add and edit repeating elements, such as the company logo or page numbering. Any element placed on the Page Master repeats on every page in the resulting document.</td>
</tr>
<tr>
<td><strong>page number object</strong></td>
<td>An object you can add to a Page Master. This object displays either the current page number, the total number of pages, both the current page and total pages, or the date. You can select from a number of date formats.</td>
</tr>
<tr>
<td><strong>post-process code</strong></td>
<td>Code that runs after the document is run. This can be used in conjunction with pre-process code. For example, using pre-process code, you could create a join. You could then use the post-process code to clear that join.</td>
</tr>
<tr>
<td><strong>pre-process code</strong></td>
<td>Code that is run before a document is accessed and applies to all objects added to a document. For example, if your document requires the joining of two tables, you can create pre-process code that joins those two tables. This join can then be used by any object in the document and any items following the pre-process code.</td>
</tr>
<tr>
<td><strong>properties window</strong></td>
<td>Shows the properties of the object or objects you selected. For example, if you select a hyperlink, the Properties window shows the properties of the hyperlink.</td>
</tr>
<tr>
<td><strong>relative positioning</strong></td>
<td>The relationship between objects.</td>
</tr>
<tr>
<td><strong>report</strong></td>
<td>A component you can insert into the page layout. A visual representation of data within a Master File. You can use Report Painter to create reports.</td>
</tr>
<tr>
<td><strong>Report Painter</strong></td>
<td>A Developer Studio tool that you can use to create and style complex reports. You can design the report in the Report Painter window, a graphical representation of the report page.</td>
</tr>
<tr>
<td><strong>simulated data</strong></td>
<td>Mock data used in your graph and chart previews. This option sends a request to the Reporting Server that gathers formatting information from the Master File. The database is not accessed, and mock data is used to visually represent the report. The formatting and styling options applied to the report are shown when viewing the simulated data.</td>
</tr>
<tr>
<td><strong>Table of Contents</strong></td>
<td>Shows a summary of the contents of the document, with page numbers, and can be printed with the document. The entries can link to any component of the compound output (page, report, or graph) and vertical sort field values (BY field values) within each component report. The entries in the Table of Contents enable you to easily navigate to a particular section while viewing the document online.</td>
</tr>
</tbody>
</table>
Index

A
accessing Document Composer 14
active dashboard characteristics 116
active dashboards 109, 113
active form controls 115
adding embedded reports 29
adding existing Page Layouts 88
adding external reports 30
adding headers and footers to overflow pages 71
adding new overflow pages 68
adding page numbers 101
aligning objects 45
aligning text 98

B
binding active reports 119
binding objects 119
bookmarks 83

C
Components toolbar 18
Compound Document Properties window 22
compound layout reports 83
compound reports 32, 34
controlling objects in the Table of Contents (TOC) 79
coordinated compound documents 31, 32, 115
coordinated reports 31
creating a Table of Contents (TOC) 76
creating active dashboards 115, 117
creating active reports 116
creating Compound Layout Reports 27
creating coordinated compound layouts 31
creating Page Masters 48
customizing overflow 56

D
Developer Studio Options Document Tab 40
document
    post-processing 27
    pre-processing 27

E
editing Page Masters 49
embedded reports 29
external reports 30

F
fixed overflow 56
fixed reports 56
flowing overflow 57, 60
flowing reports 63
formatting text 93, 97
formatting text elements 93
Formatting toolbar 20, 93

G
getting started 14
Index

H
headers and footers

I
importing images
interface

K
keyboard shortcuts

M
moving pages

O
on demand viewing
output formats
overflow options
fixed
flowing
overflow pages
headers and footers

P
page layout
page layout properties
Page Layouts
adding
saving
page layouts for active dashboards
Page Masters
page number options

page numbers
page orientation
positioning active reports in active dashboard
positioning objects
positioning options
Positioning toolbar
PowerPoint templates
previewing data
Properties and settings dialog box for active reports
QuickLinks
relative positioning of objects
relative relationships between objects
relative relationships rules
resetting page numbers
reusing Page Layouts
rules for saving Page Masters
saving Page Layouts
saving Page Masters
setting flow margins
setting flowing report overflow
Standard toolbar
synchronizing active reports
synchronizing objects
Creating Compound Reports With Document Composer
Customer Connections

Where users partner with Information Builders to provide feedback and create quality documentation.

Partner With Us

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also join a usability study to get an early look at new documentation products and services. Your participation helps us create documentation products that meet your needs.

To send us feedback or make a customer connection, contact Michele Brady, Service Director, Technical Content Management at Michele_Brady@ibi.com.

Request Permission to Use Copyright Material

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.

Visit the Information Builders Technical Content Library

To visit the Technical Content Library, go to http://documentation.informationbuilders.com/.
Creating Compound Reports
With Document Composer
Release 8.1 Version 05